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Photoshop Is an Adobe software to enhance digital
pictures. Photoshop is used throughout the world in many
Industries. Chances are today you saw many pictures that
Photoshop Is used.

In advertising still shots were probably use to improve the
look of products. To give the final touch that boosts the
opportunity of someone to remember your product.

Glamor shots for magazines, model headshots, and
websites probably had images that were Photoshop
software was used to make the subject better than the
original picture.

In sciences, business, law enforcement areas how
Important are pictures in their particular areas?

Why learn Photoshop?
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Start Adobe Photoshop CS4

. Learm how to open and save an image

. Use organizational and management features

Examine the Photoshop window

. Use the Layers and History panels
. Learn about Photoshop by using Help
. View and print an image

. Close a file and exit Photoshop
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Using Photoshop

Adobe Photoshop CS4 is an image-editing
program that lets you create and modify
digital images. ‘CS’ stands for Creative
Suite, a complete design environment.
Although Adobe makes Photoshop avail-
able as a standalone product, it also comes
bundled with all of their Creative Suite
options, whether your interests lie with
print design, web design, or multimedia
production. A digital image is a picture
in electronic form. Using Photoshop, you
can create original artwork, manipulate
color images, and retouch photographs. In
addition to being a robust application pop-
ular with graphics professionals,
Photoshop is practical for anyone who
wants to enhance existing artwork or cre-
ate new masterpieces. For example, you
can repair and restore damaged areas
within an image, combine images, and
create graphics and special effects for

the web.

TIP
In Photoshop, a digital image may be referred to as a file,
document, graphic, picture, or image.

Understanding Platform User
interfaces

Photoshop is available for both Windows
and Macintosh platforms. Regardless of
which platform you use, the features and
commands are very similar. Some of the
Windows and Macintosh keyboard com-
mands differ in name, but they have equiva-
lent functions. For example, the [Ctrl] and
[Alt] keys are used in Windows, and the
and [option] keys are used on Macintosh
computers. There are also visual differences
between the Windows and Macintosh ver-
sions of Photoshop due to the user interface
differences found in each platform.

Understanding Sources
Photoshop allows you to work with images
from a variety of sources. You can create your
own original artwork in Photoshop, use
images downloaded from the web, or use
images that have been scanned or created
using a digital camera. Whether you create
Photoshop images to print in high resolution
or optimize them for multimedia presenta-
tions, web-based functions, or animation
projects, Photoshop is a powerful tool for
communicating your ideas visually.
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Tools Youw’ll Use

New...

Open...

Browse in Bridge...
Open As...

Open As Smart Object...
Open Recent

Share My Screen...
Device Central.

Close
Close All
Close and Go To Bridge.

Save As...
CheckIn...

Save for Web & Devices...

Place...

Import
Export
Automate
Scripts
File Info.

Page Setup...
Print..
Print One Copy

Exit
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What You’ll Do

=

s

In this lesson, you'll start Photoshop for
Windows or Macintosh, then create a file.

PHOTOSHOP 1-4

Soft
Photoshop is an image-editing program.
An image-editing program allows you to
manipulate graphic images so that they
can be reproduced by professional printers
using full-color processes. Using panels,
tools, menus, and a variety of techniques,
you can modify a Photoshop image by
rotating it, resizing it, changing its colors,
or adding text to it. You can also use
Photoshop to create and open different
kinds of file formats, which enables you to
create your own images, import them
from a digital camera or scanner, or use
files (in other formats) purchased from
outside sources. Table 1 lists some of the
graphics file formats that Photoshop can
open and create.

Every image is made up of very small
squares, which are called pixels, and
each pixel represents a color or shade.
Pixels within an image can be added,
deleted, or modified.

TP
Photoshop files can become quite large. After a file is
complete, you might want to flatten it, an irreversible
process that combines all layers and reduces the file size

Using Photoshop Features
Photoshop includes many tools that you can
use to manipulate images and text. Within
an image, you can add new items and mod-
ify existing elements, change colors, and
draw shapes. For example, using the Lasso
tool, you can outline a section of an image
and drag the section onto another area of
the image. You can also isolate a foreground
or background image. You can extract all or
part of a complex image from nearly any
background and use it elsewhere.

TP
You can create logos in Photoshop. A logo is a distinctive
image that you can create by combining symbols, shapes
colors, and text. Logos give graphic identity to organiza-
tions, such as corporations, universities, and retail stores

Getting Started with Adobe Photoshop CS4
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You can also create and format text, called
type, in Photoshop. You can apply a vari-
ety of special effects to type; for example,
you can change the appearance of type
and increase or decrease the distance
between characters. You can also edit type
after it has been created and formatted.

TIP
Photoshaop records each change you make to an image
on the History panel. You can undo or redo a recorded
action as necessary. Photoshop records actions for the
current session only; it discards actions when the
program closes.

Adobe Dreamweaver CS4, a web production
software program included in the Design
Suite, allows you to optimize, preview, and
animate images. Because Dreamweaver is
part of the same suite as Photoshop, you can
jump seamlessly between the two programs.

Using these two programs, you can also
quickly turn any graphics image into a gif
animation. Photoshop and Dreamweaver let
you compress file size (while optimizing
image quality) to ensure that your files
download quickly from a web page. Using
Photoshop optimization features, you can
view multiple versions of an image and
select the one that best suits your needs.

TABLE 1: Some Supported Graphic File Formats

file filename
format extension
3D Studio .3ds
Bitmap .bmp
Cineon .cin

Dicom .dem
Filmstrip flm
Google Earth kmz
Graphics .gif

Interchange Format

JPEG Picture Format .Jipg, .jpe,
or .jpeg
PC Paintbrush .pcx
Photoshop .psd
Photoshop Encapsulated .eps

PostScript

Lesson 1 Start Adobe Photoshop CS4

file filename
format extension
Photoshop PDF .pdf
PICT file Jpet; Ppic;
or .pict
Pixar .pXr
QuickTime .mov
or .mp4
Radiance .hdr
RAW varies
Scitex CT .sct
Tagged Image .tif or .tiff
Format
Targa .tga or .vda
U3D .u3d
Wavefront .obj

The specific way you start Photoshop
depends on which computer platform you
are using. However, when you start
Photoshop in either platform, the computer
displays a splash screen, a window that
contains information about the software,
and then the Photoshop window opens.

After you start Photoshop, you can create a
file from scratch. You use the New dialog
box to create a file. You can also use the
New dialog box to set the size of the image
you’re about to create by typing dimensions
in the Width and Height text boxes.

tin
There is no single Camera RAW format, as this
is determined by your camera manufacturer.
Some raw formats you may encounter are:

.raf (Fuji)

.crw .cr2 (Canon)

.kdc .dcr (Kodak)

.mrw (Minolta)

.nef (Nikon)

.orf (Olympus)

.dng (Adobe)

.ptx .pef (Pentax)

.arw .srf (Sony)

x3f (Sigma)

.erf (Epson)

PHOTOSHOP 1-5
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Start Photoshop (Windows)

1. Click the Start button € on the taskbar.

2. Point to All Programs, point to Adobe
Photoshop €84, as shown in Figure 1, then
click Adobe Photoshop CS4.

TIP The Adobe Photoshop CS4 program
might be found in the Start menu (in the

left pane) or in the Adobe folder, which

is in the Program Files folder on the hard
drive (Win).

3. Click File on the Application bar, then click
New to open the New dialog box.

<. Double-click the number in the Width text
box, type 500, click the Width list arrow,
then click pixels (if it is not already selected).

5. Double-click the number in the Height text
box, type 400, then specify a resolution of
72 pixels/inch (if necessary).

6. Click OK.

TIP By default, the document window
(the background of the active image) is
gray. This color can be changed by right-
clicking the background and then making
a color selection.

7. Click the arrow ;L at the bottom of the image
window, point to Show, then click Document
Sizes (if it is not already displayed).

You started Photoshop in Windows, then created a

file with custom dimensions. Setting custom

dimensions lets you specify the exact size of the
image you are creating. You changed the display
at the bottom of the image window so the
document size is visible.

PHOTOSHOP 1-6

Starting Photoshop CS4 (Windows)

Understanding hardware requirements (Windows)
Adobe Photoshop CS4 has the following minimum system requirements:

Processor: Intel Xeon, Xeon Dual, Centrino, or Pentium 4 processor
Operating System: Microsoft® Windows XP SP2 or higher, or Windows Vista
Memory: 320 MB of RAM

Storage space: 650 MB of available hard-disk space

Video RAM: 64 MB; Monitor with 1024 X 768 resolution

16-bit video card and Quick Time 7 for Multimedia features

Getting Started with Adobe Photoshop CS4 1
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FIGURE 2
Starting Photoshop CS4 (Macintosh) ltems as icons view
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Understanding hardware requirements (Macintosh)

Adobe Photoshop CS4 has the following minimum system requirements:
e Processor: G4, G5, or Intel-based

Operating System: Mac OS X version 10.3 through 10.5

Memory: 320 MB of RAM (384 MB recommended)

Storage space: 1.5 GB of available hard-disk space

Monitor: 1024 X 768 or greater monitor resolution with 16-bit color or

greater video card

PostScript Printer PostScript Level 2, Adobe PostScript 3

e Video RAM: 64 MB

e (CD-ROM Drive: CD-ROM Drive required

Lesson 1 Start Adobe Photoshop CS4

Start Photoshop (Macintosh)

4. Double-click the hard drive icon on the desk-
top, double-click the Applications folder,
then double-click the Adobe Photoshop CS4
folder. Compare your screen to Figure 2.

2. Double-click the Adobe Photoshop CS4
program icon.

2. Click File on the Application bar, then click New.

TIP  If the Color Settings dialog box
opens, click No. If a Welcome screen
opens, click Close.
4. Double-click the number in the Width text
box, type 500, click the Width list arrow,
then click pixels (if necessary).

%. Double-click the number in the Height text
box, type 400, click the Height list arrow,
click pixels (if necessary), then verify a res-
olution of 72 pixels/inch.

6. Click OK.

TIP  The gray document window
background can be turned on by clicking
Window on the Application bar, then
clicking Application frame.
7. Click the arrow | P | at the bottom of the image
window, point to Show, then click Document
Sizes (if it is not already checked).

You started Photoshop for Macintosh, then
created a file with custom dimensions. You
verified that the document size is visible at the
bottom of the image window.

PHOTOSHOP 1-7
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What Youw’ll Do

In this lesson, you’ll locate and open files
using the File menu and Adobe Bridge,
flag and sort files, then save a file with

a new name.

PHOTOSHOP 1-8

Photoshop provides several options for
opening and saving a file. Often, the proj-
ect you're working on determines the
techniques you use for opening and saving
files. For example, you might want to pre-
serve the original version of a file while
you modify a copy. You can open a file,
then immediately save it with a different
filename, as well as open and save files in
many different file formats. When working
with graphic images you can open a
Photoshop file that has been saved as a
bitmap (.bmp) file, then save it as a JPEG
(.jpg) file to use on a web page.

Preferences dialog box

Number of files to
appear in Open
Recent list

You can customize how you open your files
by setting preferences. Preferences are
options you can set that are based on your
work habits. For example, you can use the
Open Recent command on the File menu to
instantly locate and open the files that you
recently worked on, or you can allow others
to preview your files as thumbnails. Figure 3
shows the Preferences dialog box options for
handling your files.

IIP In cases when the correct file format is not automat-
ically determined, you can use the Open As command on
the File menu (Win) or Open as Smart Object (Mac).

Option for thumbnail
preview

()

ey
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You can easily find the files you're looking for by
using Adobe Bridge, a stand-alone application
that serves as the hub for the Adobe Creative
Suite. See the magnifying loupe tool in the
Filmstrip view in Figure 4. You can open Adobe
Bridge (or just Bridge) by clicking the Launch
Bridge button on the Application bar. You can also
open Bridge using the File menu in Photoshop.

When you open Bridge, a series of panels allows
you to view the files on your hard drive as hierar-
chical files and folders. In addition to the Favorites
and Folders panels in the upper-left corner of

the Bridge window, there are other important
areas. Directly beneath the Favorites and Folders
panels is the Filter panel which allows you to
review properties of images in the Content panel.
In the (default) Essentials view, the Preview panel
displays a window containing the Metadata and
Keywords panels, which stores information about

a selected file (such as keywords) that can then
be used as search parameters. You can use this
tree structure to find the file you are seeking.
When you locate a file, you can click its thumb-
nail to see information about its size, format,
and creation and modification dates. (Clicking
a thumbnail selects the image. You can select
multiple non-contiguous images by pressing
and holding [Ctrl] (Win) or (Mac)

each time you click an image.) You

can select contiguous images by clicking

the first image, then pressing

[P Click a thumbnail while in Filmstrip view and the
pointer changes to a Loupe tool that magnifies content.
Drag the loupe over the filmstrip image to enlarge select
areas. The arrowhead in the upper-left corner of the win-
dow points to the area to be magnified. Clicking the arrow-
head closes the loupe.

Using the Photoshop File Info dialog box

You can use the File Info dialog box to identify a file, add a caption or other text, or add

a copyright notice. The Description section allows you to enter printable text, as shown in
Figure 5. For example, to add your name to an image, click File on the Application bar,
click File Info, then click in the Description text box. (You can move from field to field by
pressing [Tab] or by clicking in individual text boxes.) Type your name, course number, or
other identifying information in the Description text box, or click stars to assign a rating.
You can enter additional information in the other text boxes, then save all the File Info
data as a separate file that has an .xmp extension. To print selected data from the File Info
dialog box, click File on the Application bar, then click Print. Click the Color Management
list arrow, then click Output. Available options are listed in the right panel. To print the
filename, select the Labels check box. You can also select check boxes that let you print
crop marks and registration marks. If you choose, you can even add a background color or
border to your image. After you select the items you want to print, click Print.

Lesson 2 Learn How to Open and Save an Image
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TIP The terms ‘panel’ and ‘palette” are interchangeable in Adobe
CS4 programs. ‘Panel’ is used more frequently in Photoshop.

and holding [Shift] and clicking the last image
in the group. You can open a file using Bridge
by double-clicking its thumbnail, and find out
information such as the file’s format, and
when it was created and edited. You can

close Bridge by clicking File (Win) or Bridge
CS4 (Mac) on the (Bridge) Application bar,
then clicking Exit (Win) or Quit Adobe

Bridge CS4 (Mac) or by clicking the window’s
Close button.

TIP
You can reset the Adobe Bridge preferences to the factory
default by holding [CtrI][Alt] (Win) or [Option] (Mac)
while clicking the Launch Bridge button.

Understanding the Power

of Bridge

In addition to allowing you to see all your
images, Bridge can be used to rate (assign
importance), sort (organize by name, rating, and
other criteria), and label your images. Figure 4,
on the previous page, contains images that are
assigned a rating and shown in Filmstrip view.
There are three views in Bridge (Essentials,
Filmstrip, and Metadata) that are controlled by
tabs to the left of the search text box. To assist in
organizing your images, you can assign a color
label or rating to one or more images regardless
of your current view. Any number of selected
images can be assigned a color label by clicking
Label on the Application bar, then clicking one
of the six options.

PHOTOSHOP 1-10

TIP
You can use Bridge to view thumbnails of all files on your

computer. You can open any files for software installed on

your computer by double-clicking its thumbnail.

Using Bridge you can create a PDF

Presentation (a presentation in the PDF file

format). Such a presentation can be viewed
full-screen on any computer monitor, or in

Adobe Acrobat Reader as a PDF file. You can

create such a presentation by opening

Bridge, locating and selecting images using

the file hierarchy, then clicking the Output

button on the Bridge Application bar. The

Output panel, shown in Figure 6, opens and

displays the images you have selected. You
can add images by pressing [Ctrl] (Win) or

(Mac) while clicking additional images.

FIGURE 6

Output panel in Bridge

5

Sometimes it’s more efficient to create a new
image by modifying an existing one, espe-
cially if it contains elements and special
effects that you want to use again. The Save
As command on the File menu (in
Photoshop) creates a copy of the file,
prompts you to give the duplicate file a new
name, and then displays the new filename in
the image’s title bar. You use the Save As
command to name an unnamed file or to
save an existing file with a new name. For
example, throughout this book, you will be
instructed to open your Data Files and use
the Save As command. Saving your Data
Files with new names keeps the original files
intact in case you have to start the lesson
over again or you want to repeat an exercise.
When you use the Save command, you save
the changes you made to the open file.

TIP
You can also create a copy of the active file by clicking
Image on the Application bar, then clicking Duplicate. Click
0K to confirm the name of the duplicate file.

Click to create
output

i ™. Click to create

PDF

Output
preview

Selected
thumbnails
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Open dialog box for Windows
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_ keywords to a selected

file, then click any of the
displayed keywords

Drag to resize

~ thumbnails

Open a file using the
Application bar

1. Click File on the Application bar, then click Open.
2. Click the Look in list arrow (Win) or the Current
file location list arrow (Mac), then navigate to
the drive and folder where you store your
Data Files.
3. Click PS 1-1.psd, as shown in Figure 7, then
click Open.
TIP  Click Update, if you receive a message
stating that some text layers need to be
updated.
You used the Open command on the File menu to
locate and open a file.

Open a file using the Folders
panel in Adobe Bridge

1. Click the Launch Bridge button on the
Application bar, then click the Folders panel
tab | 5 | (if necessary).

Navigate through the hierarchical tree to the

drive and folder where you store your

Chapter 1 Data Files, then click the Essentials

button if it is not already selected.

2. Drag the slider (at the bottom of the Bridge
window) a third of the way between the
Smaller thumbnail size button B and the
Larger thumbnail size button 1. Compare
your screen to Figure 8.

4. Double-click the image of a butterfly
(PS 1-2.tif). Bridge is no longer visible.

5. Close the butterfly image in Photoshop.

N

You used the Folders panel tab in Adobe Bridge to

locate and open a file. This feature makes it easy

to see which file you want to use.
PHOTOSHOP 1-11
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Use the Save As command

Verify that the PS 1-1.psd window is active.

2. Click File on the Application bar, click Save As,
then compare your Save As dialog box to Figure 9.

If the drive containing your Data Files is not
displayed, click the Save in list arrow (Win)
or the Where list arrow (Mac), then navigate
to the drive and folder where you store your
Chapter 1 Data Files.
Select the current filename in the File name
text box (Win) or Save As text box (Mac)
(if necessary); type Playground, then click Save.
TIP  Click OK to close the Maximize
Compatibility dialog box (if necessary).
You used the Save As command on the File menu to
save the file with a new name. This command
makes it possible for you to save a changed version
of an image while keeping the original file intact.

Change from Tabbed to
Floating Documents

Click the Arrange Documents button [@Z ~ on
the Application bar, then click 2 Up.
TIP The Arrange Documents button is a tem-

porary change to the workspace that will be in
effect for the current Photoshop session.

Click [@5] « , then click Float All in Windows.
Compare your Playground image to Figure 10.

You changed the arrangement of open documents
from consolidation to a 2 Up format to each
image displaying in its own window.

PHOTOSHOP 1-12

Save As dialog box

Your list of files

might be different = E ‘m ‘E

New filename =

Playground image

Duplicate /):/e has
new name

Changing file formats

In addition to using the Save As command to duplicate an existing file, it is a handy way
of changing one format into another. For example, you can open an image you created in
a digital camera, then make modifications in the Photoshop format. To do this, open the
.Jjpg file in Photoshop, click File on the Application bar, then click Save As. Name the file,
click the Format list arrow, click Photoshop (*.psd, *.pdd) (Win) or Photoshop (Mac),
then click Save. You can also change formats using Bridge by selecting the file, clicking
Tools on the Application bar, pointing to Photoshop, then clicking Image Processor.
Section 3 of the Image Processor dialog box lets you determine the new file format.

Getting Started with Adobe Photoshop CS4
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Rate and filter with Bridge

Rated and
Approved file FIGURE 11 1. Click the Launch Bridge button on the
> Images in Adobe Bridge Application bar.

g 2. Click the Folders panel tab | Foi 5 | if itis
e o N = not already selected, then click the drive and
g folder where you store your Chapter 1 Data
Files on the File Hierarchy tree (if necessary).
3. Click the butterfly image, file PS 1-2.tif to select it.
4. Press and hold [Ctrl] (Win) or (Mac), click
PS 1-1.psd (the image of the playground), then
release [Ctrl] (Win) or (Mac).
5. Click Label on the Application bar, then
click Approved.
@. Click PS 1-1.psd, click Label on the
Application bar, then click ***. See Figure 11.
7. Click View on the Application bar, point to
Sort, then click By Type. Compare your screen
FIGURE 12 to Figure 12.

Getting photos from
your camera

You can use Bridge to
move photos from your
camera into your com-
puter by plugging your
camera into your com-
puter, opening Adobe
Bridge, clicking File on
the (Bridge) Application
bar, then clicking Get
Photos from Camera.

Once you do this, the Sorted files The order of the files is changed.

Adobe Bridge CS4 Photo o ; T TIP You can also change the order of files
Downloader dialog box AT oAt oviur + _ & (in the Content panel) using the Sort by
opens. This dialog box T —_— . ek Filename list arrow in the Filter panel. When

you click the Sort by Filename list arrow,
you’ll see a list of sorting options. Click the
T option you want and the files in the Content

lets you decide from
which device you’ll down-

load images, where you
want to store them, and
whether or not you want
to rename them, among

panel will be rearranged.

Click View on the Application bar, point to
Sort, then click Manually.

TIP You can change the Bridge view at any

other options. time, depending on the type of information

you need to see.

9. Click File (Win) or Adobe Bridge CS4 (Mac)
on the (Bridge) Application bar, then click
Exit or Quit Adobe Bridge CS4 (Mac).

You labeled files using Bridge, sorted the files in a

folder, then changed the sort order. When finished,

you closed Bridge.

Siee 20450
Omensions 790 1 450
L Dimensions (n inches) L37x 11"
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What Youw’ll Do

Get started with Version Cue

In this lesson, you'll learn how to use
Version Cue and Bridge.

Your list of Favorites ___|

may differ

PHOTOSHOP 1-14

— m Bridge Home

Learning about Version Cue
Version Cue is a file versioning and man-
agement feature of the Adobe Creative Suite
that can be used to organize your work
whether you work in groups or by yourself.
Version Cue is accessed through Bridge. You
can see Version Cue in Bridge in two differ-
ent locations: the Favorites tab and the
Folders tab. Figure 13 shows Version Cue in
the Favorites tab of Bridge. You can also
view Version Cue in the Folders tab by col-
lapsing the Desktop, as shown in Figure 14.

FIGURE 13
Favorites tab in Adobe Bridge

FavomriTes [ Fouomme L e

.g Computer

S | Version Cue
X Bl

E Desktop
“N Documents

P
& Pictures
3

Understanding Version Cue
Workspaces

Regardless of where in Bridge you access
it (the Favorites or Folders tab), Version
Cue installs a workspace in which it
stores projects and project files, and keeps
track of file versions. The Version Cue
workspace can be installed locally on your
own computer and can be made public or
kept private. It can also be installed on a
server and can be used by many users
through a network.

F E 14

Folders tab in Adobe Bridge

FAMORIYES,| FOLDERS
BE Desktop
A Computer
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Using Version Cue’s
Administrative Functions

Once you log into Version Cue using Adobe
Drive (shown in Figure 15), you can control
who uses the workspace and how it is used
with the tabs at the top of the screen. Adobe
Drive, which you use to connect to Version
Cue, lets you open your server, browse projects
and other servers, and perform advanced tasks.

FIGURE 15

Adobe Drive and Version Cue

Making Use of Bridge

You've already seen how you can use

Bridge to find, identify, and sort files. But
did you know that you can use Bridge
Center to organize, label, and open files as a
group? First you select one or more files,
right-click the selection (Win) or [control]-
click the selection (Mac), then click Open, or
Open With, to display the files in your

favorite CS4 program. You can apply labels,
and ratings, or sort the selected files.

TIP
You can use Bridge to stitch together panoramic photos,
rename images in batches, or automate image conversions
with the Tools menu. Select the file(s) in Bridge you want to
modify, click Tools on the Application bar, paint to Photoshap,
then click a command and make option modifications.

¥z Adobe Drive CS4

=  ADOBE’ DRIVE

Select a service to establish a connection

Lesson 3 Use Organizational and Management Features
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What Youw’ll Do

e

@ In this lesson, you’ll arrange documents
and change the default display, select a
tool on the Tools panel, use a shortcut key
to cycle through the hidden tools, select
and add a tool to the Tool Preset picker,
use the Window menu to show and hide
panels in the workspace, and create a

The Photoshop workspace is the area
within the Photoshop program window

that includes the entire window, from the
command menus at the top of your screen to
the status bar (Win) at the bottom. Desktop
items are visible in this area (Mac). The
(Windows) workspace is shown in Figure 16.

In Windows, the area containing the menu
bar (containing Photoshop commands) and
the title bar (displaying the program name) is
called the Application bar. These two areas
have been combined to use space more
efficiently. On the Mac, the main menus

are at the top of the screen, but not on the
Application bar. If the active image window

is maximized, the filename of the open

unnamed file is Untitled-1, because it has
not been named. The Application bar also
contains the workspace switcher, a Close
button, and Minimize/Maximize, and Restore
buttons (Win).

You can choose a menu command by
clicking it or by pressing [Alt] plus the
underlined letter in the menu name (Win).
Some commands display shortcut keys on
the right side of the menu. Shortcut keys
provide an alternative way to activate
menu commands. Some commands might
appear dimmed, which means they are not
currently available. An ellipsis after a
command indicates additional choices.

customized workspace.

N[IP Overcoming information overload

One of the most common experiences shared by first-time Photoshop users is information overload. There
are just too many places and things to look at! When you feel your brain overheating, take a moment and
sit back. Remind yourself that the active image area is the central area where you can see a composite of
your work. All the tools and panels are there to help you, not to add to the confusion. The tools and fea-
tures in Photoshop CS4 are designed to be easier to find and use, making any given task faster to complete.
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TIP
By default, each image is displayed in its own tab, but you
can change this so each image floats in its own window

Finding Tools Everywhere

The Tools panel contains tools associated
with frequently used Photoshop commands.
The face of a tool contains a graphical repre-
sentation of its function; for example, the
Zoom tool shows a magnifying glass. You can
place the pointer over each tool to display a
tool tip, which tells you the name or func-
tion of that tool. Some tools have additional

FIGURE 16
Workspace

hidden tools, indicated by a small black tri-
angle in the lower-right corner of the tool.

TP
You can view the Tools panel in a 2-column format by
clicking the Expand arrow in its upper-left corner.

The options bar, located directly under the
Application bar, displays the current set-
tings for each tool. For example, when you
click the Type tool, the default font and font
size appear on the options bar, which can be
changed if desired. You can move the

options bar anywhere in the workspace for
easier access. The options bar also contains
the Tool Preset picker. This is the left-most
tool on the options bar and displays the
active tool. You can click the list arrow on
this tool to select another tool without hav-
ing to use the Tools panel. The options bar
also contains the panel well, an area where
you can assemble panels for quick access.

Panels, sometimes called palettes, are small
windows used to verify settings and modify
images. By default, panels appear in stacked
groups at the right side of the window.

= Workspace switcher

Double-click the Application =
icon to close the program [

Options bar

3
2,
Tool Preset picker o)
: 5
Tools panel o
s
Workspace —{ | V| v
s
7.
fpd
"
&
Status bar

Minimized document ~
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A collection of panels usually in a vertical
orientation is called a dock. The dock is the
dark gray bar above the collection of panels.
The arrows in the dock are used to maximize
and minimize the panels. You can display a
panel by simply clicking the panel tab, making
it the active panel. Panels can be separated and
moved anywhere in the workspace by dragging
their tabs to new locations. You can dock a
panel by dragging its tab in or out of a dock. As
you move a panel, you'll see a blue highlighted
drop zone. A drop zone is an area where you
can move a panel. You can also change the
order of tabs by dragging a tab to a new
location within its panel. Each panel contains a
menu that you can view by clicking the list
arrow in its upper-right corner.

TIP
You can reset panels to their default locations at any time by
clicking Essentials on the workspace switcher. (If Essentials is not
displayed, click the workspace switcher. then click Essentials.)

The status bar is located at the bottom of
the program window (Win) or work area
(Mac). It displays information, such as the file
size of the active window and a description of
the active tool. You can display other informa-

tion on the status bar, such as the current
tool, by clicking the black triangle to view a
pull-down menu with more options.

Rulers can help you precisely measure and
position an object in the workspace. The
rulers do not appear the first time you use
Photoshop, but you can display them by
clicking Rulers on the View menu.

Each tool has a corresponding shortcut key.
For example, the shortcut key for the Type
tool is T. After you know a tool’s shortcut key,
you can select the tool on the Tools panel by
pressing its shortcut key. To select and cycle
through a tool’s hidden tools, you press and
hold [Shift], then press the tool’s shortcut key
until the desired tool appears.

TP
Tools that have assigned shortcut keys have spring-loaded
keyboard shortcuts. Spring-loaded keyboard shortcuts let
you temporarily change the active tool. If, for example, you've
selected the Gradient tool and you want to move an object,
press and hold V. For as lang as you hold V, the Move tool
will be in effect. Release the V and you're back to the
Gradient tool.

Creating customized keyboard shortcuts

Keyboard shortcuts can make your work with Photoshop images faster and easier. In fact,
once you discover the power of keyboard shortcuts, you may never use menus again. In
addition to the keyboard shortcuts that are preprogrammed in Photoshop, you can create
your own. To do this, click Edit on the Application bar, then click Keyboard Shortcuts.
The Keyboard Shortcuts and Menus dialog box opens, as shown in Figure 17.

PHOTOSHOP 1-18

Kaybosra Shomcuts snd Manus ===

Photoshop makes it easy for you to position
elements you work with just where you
want them. If you move elements around to
make your environment more convenient,
you can always return your workspace to its
original appearance by resetting the default
panel locations. Once you have your work
area arranged the way you want it, you can
create a customized workspace by clicking
the workspace switcher on the Application
bar, then clicking Save Workspace. If you
want to open a named workspace, click

the workspace switcher, then click the
name of the workspace you want to use.

In addition, Photoshop comes with

many customized workspaces that are
designed for specific tasks.

Instructions to edit shortcuts
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FIGURE 1 Select a tool
Hidden tools

TIP Composition 101

What makes one image merely okay and
another terrific? While any such judge-
ment is subjective, there are some rules
governing image composition. It goes
without saying that, as the artist, you

Click the Lasso tool ¢~ on the Tools panel,
3 press and hold the mouse button until a list
i o of hidden tools appears, then release the
mouse button. See Figure 18. Note the
shortcut key, L, next to the tool name.

File Edit Image Layer

Click the Polygonal Lasso tool %7 on the

have a message you're trying to deliver [E) = grrameten |

... something you’re trying to say to the A ey - Tools panel.

viewer. This is true whether the medium &, e %. Press and hold [Shift], press [L] three times
is oil painting, photography, or Shortcut key 2. 5 to cycle through the Lasso tools, then release
Photoshop imagery. &, [Shift]. Did you notice how the options bar
Elements under your control in your { changes for each selected Lasso tool?

TIP  You can return the tools to their default
setting by clicking the Click to open the
Tool Preset picker list arrow on the options
bar, clicking the list arrow, then clicking
Reset All Tools.
You selected the Lasso tool on the Tools panel
and used its shortcut key to cycle through the Lasso
tools. Becoming familiar with shortcut keys can
speed up your work and make you more efficient.

composition are tone, sharpness, scale,
and arrangement. (You may see these
items classified differently elsewhere,
but they amount to the same concepts.)
Tone is the brightness and contrast
within an image. Using light and shad-
ows you can shift the focus of the
viewer’s eye and control the mood.
Sharpness is used to direct the viewer’s 5 |
eye to a specific area of an image. Scale
is the size relationship of objects to one _:
another, and arrangement is how objects -, -
are positioned to one another. B
=1

LA g

N

[_ ﬁ':—](;—,‘\.

Are objects in your image contributing
to clarity or clutter? Are similarly-sized
objects confusing the viewer? Would

blurring one area of an image change Learning shortcut keys

the viewer’s focus? Don’t worry about learning shortcut keys. As you become more familiar
These are ’(_0015 you have to influence with Photoshop, you’ll gradually pick up shortcuts for menu commands,
your artistic expression. Make sure the such as saving a file, or Tools panel tools, such as the Move tool. You'll
viewer understands what you want seen. notice that as you learn to use shortcut keys, your speed while working with

Photoshop will increase and you’ll complete tasks with fewer mouse clicks.
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Select a tool from the Tool
Preset picker

Click the Click to open the Tool Preset
picker list arrow % [-| on the options bar.

The name of a button is displayed in a tool
tip, the descriptive text that appears when
you point to the button. Your Tool Preset
picker list will differ, and may contain no
entries at all. This list can be customized by
each user.

Deselect the Current Tool Only check box (if
necessary). See Figure 19.

Double-click Magnetic Lasso 24 pixels in
the list.

You selected the Magnetic Lasso tool using the
Tool Preset picker. The Tool Preset picker makes
it easy to access frequently used tools and

their settings.

Using the Full Screen Mode

Active tool displays
in Tool Preset
picker button

Using the Tool Preset picker

(B8 File Edit Image Layer Selact Fi

i

y

Heaaling Brush 21 pixals
Vx: Magnatic Lasso 24 pixals
’ZI. Crop 4 inch x 6 inch 300 ppi
EI. Crop § inch x 3 inch 300 ppi
m. Crop 5 inch x 4 inch 300 ppi
i S -
Current Toal Only

:;u.‘ !M.I ]_m:“ L & Feather: 0 px <

A

By default, Photoshop displays images in consolidated tabs. This means that each image
is displayed within its own tab. You can choose from three other modes: Maximized
Screen Mode, Full Screen Mode with Application Bar, and Full Screen Mode. And why
would you want to stray from the familiar Standard Screen Mode? Perhaps your image is
so large that it’s difficult to see it all in Standard Mode, or perhaps you want a less clut-
tered screen. Maybe you just want to try something different. You can switch between
modes by clicking the Change Screen Mode button (located in the Application controls
area of the Application bar) or by pressing the keyboard shortcut F. When you click this
button, the screen displays changes. Click the Hand tool (or press the keyboard shortcut
H), and you can reposition the active image, as shown in Figure 20.
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List arrow adds new
tools and displays
more options

Full screen mode with Application bar

Use hand pointer to

reposition image

Click to change
screen modes
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IGNTIP  Arranging

emphasize a message or reveal
information. For example, if a
large image is used, it should be
easy for the reader to connect
the image with any descriptive
text. There should be an easily
understood connection between
the text and the artwork, and
the reader should be able to
seamlessly connect them.

Modifying a tool preset

Move tool added to preset picker

New Tool Preset...

Rename Tool Preset...
Delete Tool Preset

Sort By Tool

Show All Teol Prasets
Show Current Tool Presets
Text Only

Small List

Large List

Reset Tool

Reset All Tools

Preset Manager..

Reset Tool Presets.
Load Tool Presets...

Save Tool Pres
Replace Tool Presets..

Art History
Brushes

Crop and Marquee
Text

only current
tool

Add a tool to the Tool
Preset picker

Click to
PR dispiay Click the Move tool ™ he Tool |
. ; P el ick the Move tool ™+ on the Tools panel.
The appearance of elements in an Esntng ois) 21 oot menu : : P
image is important, but of equal ; » options Cf‘Ck thf’ Click to ‘:p;e,'}" the Tool PAreset
importance is the way in which Y Magnatic Lasso 24 pixals e picker list arrow >+ [ on the options bar.
the elements are arranged. The L crop 4 inch x & inch 300 ppi A0 Click the list arrow -= on the Tool
components pt' any'image should 2§, Crop  inch x 3 inch 300 ppi panel Preset picker.
form a cohesive unit so that the A Click New Tool Preset, then click OK to
reader is unaware of all the rrant Forl Oy Selected accept the default name (Move Tool 1).
different parts, yet influenced by ‘ check box Compare your list to Figure 21.
the way they work togethe e _ displays
B ey v s peeer g Tool Preset picker list arrow menu piicy

TIP You can display the currently selected
tool alone by selecting the Current Tool Only
check box.
You added the Move tool to the Tool Preset picker.
Once you know how to add tools to the Tool
Preset picker, you can quickly and easily cus-
tomize your work environment.

Change the default display

Click Edit (Win) or Photeshop (Mac) on the
Application bar, then click Preferences
(Win) or point to Preferences, then click
Interface (Mac).

Click Interface in the left panel (Win), click
the Open Documents in Tabs check box to
deselect it, then click OK.

You changed the default display so that each time
you open Photoshop, each image will display in its
own window rather than in tabs.

Once you've created tool presets, you'll probably want to know how they can be
deleted and renamed. To delete any tool preset, select it on the Tool Preset
picker panel. Click the list arrow on the Tool Preset picker panel to view the
menu, shown in Figure 22, then click Delete Tool Preset. To rename a tool
preset, click the same list arrow, then click Rename Tool Preset.
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Show and hide panels

=ch

4

o

6.

Click Window on the Application bar, then
verify that Color has a check mark next to it,
then close the menu.

Click the Swatches tab next to the Color tab
to make the Swatches panel active, as
shown in Figure 23.

Click the Collapse to Icons arrow to
collapse the panels.

Click the Expand Panels arrow to expand
the panels.

Click Window on the Application bar, then
click Swatches to deselect it.

1P You can hide all open panels by pressing
[Shift], then [Tab], then show them by press-
ing [Shift], then [Tab] again. To hide all open
panels, the options bar, and the Tools panel,
press [Tab], then show them by pressing
[Tab] again.

Click Window on the Application bar, then click
Swatches to redisplay the Swatches panel.

You collapsed and expanded the panels, then
used the Window menu to show and hide the
Swatches panel. You might want to hide panels at
times in order to enlarge your work area.

Active Swatches panel

_ Swalches tab
is active

NTIP Balancing
objects

The optical center occurs approxi-
mately three-eighths from the top

of the page and is the point around
which objects on the page are
balanced. Once the optical center

is located, objects can be positioned
around it. A page can have a sym-
metrical or asymmetrical balance
relative to an imaginary vertical

line in the center of the page. In a
symmetrical balance, objects are
placed equally on either side of the
vertical line. This type of layout tends
toward a restful, formal design. In an
asymmetrical balance, objects are
placed unequally relative to the verti-
cal line. Asymmetrical balance uses
white space to balance the positioned
objects, and is more dynamic and
informal. A page with objects
arranged asymmetrically tends to
provide more visual interest because
it is more surprising in appearance.

[

YESIGNTIP Considering ethical implications
Because Photoshop enables you to make so many dramatic changes to images, you should consider the ethical ramifications
and implications of altering images. Is it proper or appropriate to alter an image just because you have the technical expertise
to do so? Are there any legal responsibilities or liabilities involved in making these alterations? Because the general public is
more aware about the topic of intellectual property (an image or idea that is owned and retained by legal control) with the
increased availability of information and content, you should make sure you have the legal right to alter an image, especially
if you plan on dispiaying or distributing the image to others. Know who retains the rights to an image, and if necessary, make
sure you have written permission for its use, alteration, and/or distribution. Not taking these precautions could be costly.
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FIGURE 25
Image Size dialog box

Save Workspace dialog box Create a customized

Lesson 4

) ) workspace
Save Workspace Image Size
Name: Legacyl [ save | Pixel Dimensions: 922.9K s g 1. Click Window on the Application bar, click
—2eNE I »,_ |
- e Width: B SrT = ] Faneai] History, then drag the newly displayed panel
7] Panel Locations Height: 450 e 25 - in the gray space beneath the Swatches panel.
Keyboard Shortcuts AULO:.. (Hint: When you drag one panel into another,
Panos Rokimeant Sae; you’ll see a light blue line, indicating that the
width: 1.75 inches v :l“ new panel will dock with the existing panels.)
Height> 1.125 inches b 2. Click Window on the Application bar, point
Resolution: 400 pixels/inch  + to Workspace, then click Save Workspace.
7] Scale Styles a. Type Legacy in the Name text box, then verify
71 Constrain Proportions that only Panel Locations has a check mark
EBEROe a0k beside it, as shown in Figure 24.
Bicubic (best for smooth gradients) - :
4. Click Save.

Resizing an image

You may have created the perfect image, but the size may not be correct for your print
format. Document size is a combination of the printed dimensions and pixel resolution.
An image designed for a website, for example, might be too small for an image that will be
printed in a newsletter. You can easily resize an image using the Image Size command on
the Image menu. To use this feature, open the file you want to resize, click Image on the
Application bar, then click Image Size. The Image Size dialog box, shown in Figure 25,
opens. By changing the dimensions in the text boxes, you'll have your image resized in no
time. Note the check mark next to Resample Image. With resampling checked, you can
change the total number of pixels in the image and the print dimensions independently.
With resampling off, you can change either the dimensions or the resolution; Photoshop
will automatically adjust whichever value you ignore.

Examine the Photoshop Window

5. Click Window on the Application bar, then
point to Workspace.

The name of the new workspace appears on
the Window menu.
TIP  You can use the Rotate View tool on
the Application bar to non-destructively
change the orientation of the image
canvas. Click the Reset View button on
the options bar to restore the canvas to its
original angle.

6. Click Essentials (Default).

7. Click the workspace switcher on the
Application bar, then click Legacy.

8. Click the workspace switcher on the Application
bar, then click Essentials.

You created a customized workspace, reset the

panel locations, tested the new workspace, then

reset the panel locations to the default setting.

Customized workspaces provide you with a work

area that is always tailored to your needs.
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What Youw’ll Do Lez ing Al it Layers that are in a stack. It’s possible for your

tAveRs |CHATNES] A layer is a section within an image that can file to quickly accumulate dozens of
Norms tvi| 100% » be manipulated independently. Layers allow layers. The Layers panel displays all the
tock: L] 7 & @ 100% 1: you to control individual elements within an layers in an open file. You can use the
= Eﬂ : Sy ' image and create great dramatic effects and Layers panel to create, copy, delete,
® [ ] whtados variations of the same image. Layers enable display, hide, merge, lock, group or
® [ ] roaan you to easily manipulate individual charac- reposition layers.
Background a teristics within an image. Each Photoshop

file has at least one layer, and can contain TIp
any individual layers, or g ps of layers. ; . ;

many individual layers, or groups of laye In Photoshop, using and understanding layers is the key to

You can think of layers in a Photoshop SuCCess

image as individual sheets of clear plastic

Ve 2 T S T

@ In this lesson, you'll hide and display a

layer, move a layer on the Layers panel, Setting preferences
and then undo the move by deleting the The Preferences dialog box contains several topics, each with its own settings: General;
Layer Order state on the History panel. Interface; File Handling; Performance; Cursors; Transparency & Gamut; Units &

Rulers; Guides, Grid, & Slices; Plug-Ins; Type; and Camera Raw. To open the
Preferences dialog box, click Edit (Win) or Photoshop (Mac) on the Application bar,
point to Preferences, then click a topic that represents the settings you want to change.
If you move panels around the workspace, or make other changes to them, you can
choose to retain those changes the next time you start the program. To always start a
new session with default panels, click Interface on the Preferences menu, deselect the
Remember Panel Locations check box, then click OK. Each time you start Photoshop,
the panels will be reset to their default locations and values.
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The order in which the layers appear on the
Layers panel matches the order in which
they appear in the image; the topmost layer
in the Layers panel is the topmost layer on
the image. You can make a layer active by
clicking its name on the Layers panel.
When a layer is active, it is highlighted on
the Layers panel, and the name of the layer
appears in parentheses in the image title
bar. Only one layer can be active at a time.
Figure 26 shows an image with its Layers
panel. Do you see that this image contains
six layers? Each layer can be moved or
modified individually on the panel to give a
different effect to the overall image. If you
look at the Layers panel, you'll see that the
Finger Painting text layer is dark, indicat-
ing that it is currently active.

TP
Get in the habit of shifting your eye from the image in
the work area to the Layers panel. Knowing which layer
is active will save you time and help you troubleshoot
an image

You can use the Layers panel to control
which layers are visible in an image. You
can show or hide a layer by clicking the
Indicates layer visibility button next to the
layer thumbnail. When a layer is hidden,
you are not able to merge it with another,
select it, or print it. Hiding some layers can

Lesson 5 Use the Layers and History Panels

make it easier to focus on particular areas
of an image.

Photoshop records each task you complete in
an image on the History panel. This record
of events, called states, makes it easy to see
what changes occurred and the tools or com-
mands that you used to make the modifica-
tions. The History panel, shown in Figure 26,
displays up to 20 states and automatically
updates the list to display the most recently
performed tasks. The list contains

Layers and History panels

History e T

panel tab
History ] Bt Typa Layer
slates T T &ot Typs Layar
state:

Layar Properties

the name of the tool or command used to
change the image. You can delete a state on
the History panel by selecting it and drag-
ging it to the Delete current state button.
Deleting a state is equivalent to using the
Undo command. You can also use the
History panel to create a new image from
any state.

[P

When you delete a History state, you undo all the events
that occurred after that state

” Layers panel tab

i} » [:] Background Q

Lock: B o ) Fill: 10066

Make a layer active
by clicking its name

Q& 4 @

PHOTOSHOP 1-25

Mr. Dave Schmidt

Adobe Photoshop CS4



Hide and display a layer

1. Click the Toddler layer on the Layers panel.

TIP Depending on the size of the window,
you might only be able to see the initial
characters of the layer name.

2. Verify that the Show Transform Controls
check box on the options bar is not checked,
then click the Indicates layer visibility button

on the Toddler layer to display the
image, as shown in Figure 27.

TIP By default, transparent areas of an

image have a checkerboard display on the

Layers panel.

3. Click the Indicates layer visibility button =
on the Toddler layer to hide the layer.

You made the Toddler layer active on the Layers
panel, then clicked the Indicates layer visibility
button to display and hide a layer. Hiding layers
is an important skill that can be used to remove
distracting elements. Once you’ve finished work-
ing on a specific layer, you can display the
additional layers.

Playground image

ESIENTIALS +

Visible L
Toddler ’ \
layer ‘
y e Toddler
Indicates layer layer

visibility button

DESIGNITIP Overcoming the fear of white space
One design element that is often overlooked is white space. It’s there on every page, and it doesn't seem to be doing
much, does it? Take a look at a typical page in this book. Is every inch of space filled with either text or graphics? Of
course not. If it were it would be impossible to read and it would be horribly ugly. The best example of the use of
white space are the margins surrounding a page. This white space acts as a visual barrier—a resting place for the
eyes. Without white space, the words on a page would crowd into each other, and the effect would be a cramped,
cluttered, and hard to read page. Thoughtful use of white space makes it possible for you to guide the reader’s eye
from one location on the page to another. For many, one of the first design hurdles that must be overcome is the
irresistible urge to put too much sfu/# on a page. When you are new to design, you may want to fill each page com-
pletely. Remember, less is more. Think of white space as a beautiful frame setting off an equally beautiful image.
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FIGURE 28
Layer moved in Layers panel

Norms! v Opscity: 100% *

r being mov
lock: (] 7 + @ Fill:| 3009 | » || o~ Laye be ORI ed

___ Pointer when dragging layer

FIGURE 29
Result of moved layer

Visible shadow and .
toddler’s arm ’

FIGURE 30
Deleting a History state

P 4 |
History panel tab New layer

location

Layer Order slate
created when the
layer was moved

HISTORY [8CT
7 B

o Selected state

———__ Pointer when dragging a history
state to the Delete current state
button

Lesson 5 Use the Layers and History Panels

Move a layer on the Layers
panel and delete a state on
the History panel

N

3.

.. 4

Click the Indicates layer visibility button
on the Toddler layer on the Layers panel.

Click the workspace switcher list arrow on
the Application bar, then click Legacy.
Click and drag the Pony-tail girl layer on the
Layers panel, beneath the Toddler layer in
the panel, as shown in Figure 28.
The shadow of the toddler is now visible. See
Figure 29.
Click Layer Order on the History panel, then
drag it to the Delete current state button

s on the History panel, as shown in
Figure 30.

TIP" Each time you close and reopen an
image, the History panel is cleared.

The shadow of the toddler is now less visible.
Click File on the Application bar, then click Save.

You moved the Pony-tail girl layer so it was
behind the Toddler layer, then returned it to its
original position by dragging the Layer Order state
to the Delete current state button on the History
panel. You can easily use the History panel to
undo what you’ve done.
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What You’ll Do

—

Why colors somatimes don't mateh

?_5L

&80

In this lesson, you’ll open Help, then view
and find information from the list of
topics and the Search feature.

PHOTOSHOP 1-28

Photoshop features an extensive Help sys-
tem that you can use to access definitions,
explanations, and useful tips. Help informa-
tion is displayed in a browser window, so
you must have web browser software
installed on your computer to view the
information; however, you do not need an

Internet connection to use Photoshop Help.

The Home page of the Help window has
links in the right pane that you can use to
retrieve information about Photoshop com-
mands and features. In the left pane is a list
of topics from which you can choose. Help
items have a plus sign (+) to the left of the

Help links

topic name. The plus sign (+) indicates that
there are subtopics found within. To see the
subtopics, click the plus sign (+). Topics and
subtopics are links, meaning that the text is
clickable. When you click any of the links,
the right pane will display information
(which may also contain links). The Search
feature is located in a tab on the toolbar
(above the left and right panes) in the form
of a text box. You can search the Photoshop
Help System by typing in the text box, then
pressing [Enter] (Win) or [return] (Mac).

Topics in the Help window

Using Adobe Photoshop CS4

w
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Find information in Contents

Contents section of the Help window

== 1. Click Help on the Application bar, then click
A e TG ; Photoshop Help.

TIP You can also open the Help window by
pressing [F11 (Win) or [/1 (Mac).

Click the plus sign (+) to the left of the

Adobe Color Picker overview

i word Color.

Choosing S e TR

Colors topic in e et s i G A s 3. Click the plus sign (+) to the left of Choosing

Contents o e e S e N i e (o i e Rl e et s o colors, then click Adobe Color Picker

S e e e e overview in the left pane. See Figure 32.

[P You can maximize the window (if

Subtopic you want to take advantage of the full
screen display).

Bear in mind that Help is web-driven and,
like any web site, can change as errors and
inconsistencies are found.

You used the Photoshop Help command on the
Help menu to open the Help window and view a
topic in Contents.

Understanding the differences between monitor,

images, and device resolution

Image resolution is determined by the number of pixels per inch (ppi) that are
printed on a page. Pixel dimensions (the number of pixels along the height and
width of a bitmap image) determine the amount of detail in an image, while
image resolution controls the amount of space over which the pixels are printed.
High resolution images show greater detail and more subtle color transitions
than low resolution images. Device resolution or printer resolution is measured
by the ink dots per inch (dpi) produced by printers. You can set the resolution of
your computer monitor to determine the detail with which images will be dis-
played. Each monitor should be calibrated to describe how the monitor repro-
duces colors. Monitor calibration is one of the first things you should do because
it determines whether your colors are being accurately represented, which in
turn determines how accurately your output will match your design intentions.
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Get help and support § 33
Community Help window

1. Click Help on the Application bar, then click s
Photoshop Help.

2. Click the link beneath the Community Help

icon (http://www.adobe.com/go/Ir_ .
Photoshop_community). Compare your Help
window to Figure 33.

You accessed the Community Help feature.

[~ TRUSTe

EZESXZN suppont | Communtty Help v

Using How-To Help features

Using Help would always be easy if you knew the name of the feature
you wanted up look up. To help you find out how to complete com-
mon tasks, Photoshop has a listing of “How-To’s” in the Help menu.
Click Help on the Application bar, point to the How-To you'd like to
read, as shown in Figure 34, then click the item about which you want
more information.

PHOTOSHOP 1-30

[rep]
Photoshop Help.
About Photoshop..
About Plug-In
Patent and Legal Notices

System Info...

Registration.
Deactivate.,
Updates

GPU.
Photoshop Online.

How to Create Web Images
How to Customize and Automate

How to Prepare Art for Other Applications
How to Print Photos

How to Work with 3D Images

How to Work with Color

How to Work with Layers and Selections
How to Work with Type

How-To Help topics

Add contrast to a photo
Crop and straighten photos
Dodge or burn areas
Make a frame

Remove red eye
Sharpen using Unsharp Mask

3

»

4 Remove a color cast with Auto Color
»

»

»
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Search text box in Help

o Why colors sometimes don’t match
Search text =T
175> SR (Rl 0 ccicomicninatinnll

Find information using Search

1. Click the Search text box in the Help window.
2. Type print quality, then press [Enter] (Win)
or [return] (Mac).
TIP You can search for multiple words by
inserting a space; do not use punctuation in
the text box.
Scroll down the left pane (if necessary), click
2 or Next to go to the next page, scroll down
(if necessary), click Why colors sometimes
don’t match, then compare your Help screen
to Figure 35.
4. Click the Close box on your browser window
or tab when you are finished reading the topic.

You entered a search term, viewed search results,

then closed the Help window.

IO

Additional keyboard shortcuts

Keys for using panels

Result | windows Mac 08

ai-chick New button

Lesson 6 Learn About Photoshop by Using Help

Finding hidden keyboard shortcuts

There are oodles of keyboard shortcuts in Photoshop, and not all of
them are listed in menus. Figure 36 contains a table of additional
keyboard shortcuts that are not available on menus or ScreenTips.
You can find this help topic by searching on keyboard shortcuts.
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What You’ll Do

In this lesson, you’ll use the Zoom tool on
the Application bar and Tools panel to
increase and decrease your views of the
image. You’ll also change the page
orientation settings in the Page Setup
dialog box, and print the image.

PHOTOSHOP 1-32

When you edit an image in Photoshop, it
is important that you have a good view of
the area that you are focusing on.
Photoshop has a variety of methods that
allow you to enlarge or reduce your cur-
rent view. You can use the Zoom tool by
clicking the image to zoom in on (magnify
the view) or zoom out of (reduce the view)
areas of your image. Zooming in or out
enlarges or reduces your view, not the
actual image. The maximum zoom factor
is 1600%. The current zoom percentage
appears in the document’s title bar, on the
Navigator panel, on the status bar, and on
the Application bar. When the Zoom tool is
selected, the options bar provides addi-
tional choices for changing your view, as
shown in Figure 37. For example, the
Resize Windows To Fit check box automat-
ically resizes the window whenever you
magnify or reduce the view. You can also
change the zoom percentage using the
Navigator panel and the status bar by typ-
ing a new value in the zoom text box.

In many cases, a professional print shop
might be the best option for printing a
Photoshop image to get the highest quality.
Lacking a professional print shop, you can
print a Photoshop image using a standard
black-and-white or color printer from within
Photoshop, or you can switch to Bridge and
then choose to send output to a PDF or Web
Gallery. The printed image will be a compos-
ite of all visible layers. The quality of your
printer and paper will affect the appearance
of your output. The Page Setup dialog box
displays options for printing, such as paper
orientation. Orientation is the direction in
which an image appears on the page. In por-
trait orientation, the image is printed with
the shorter edges of the paper at the top and
bottom. In landscape orientation, the
image is printed with the longer edges of the
paper at the top and bottom.

Use the Print command when you want to
print multiple copies of an image. Use the
Print One Copy command to print a single
copy without making dialog box selections,
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Mr. Dave Schmidt

Adobe Photoshop CS4



and use the Print dialog box when you want to conversions to color values appropriate for the Window menu) to open multiple views of

handle color values using color management. selected printer. If you choose to let the printer the same image. You can change the zoom
determine the colors, the printer will convert percentage in each view so you can spot-
document color values to the corresponding light the areas you want to modify, and
n Printing printer color values. In this scenario, then modify the specific area of the image
The Print dialog box that opens when you click Photoshop does not alter the color values. If in each view. Because you are working on
Print on the File menu lets you determine no color management is selected, no color val- the same image in multiple views, not in
how colors are output. You can click the Color ues will be changed when the image is printed. multiple versions, Photoshop automati-
Handling list arrow to choose whether to use cally applies the changes you make in one
color management, and whether Photoshop or in view to all views. Although you can close
the printing device should control this Mu the views you no longer need at any time,
process. If you let Photoshop determine the You can use the New Window command Photoshop will not save any changes until
colors, Photoshop performs any necessary (accessed by pointing to Arrange on the you save the file.

Zooms the window fo

# i a8
Zoom tool options bar """ the print resolution

A - E | Rasiza Windows To Fit Zoom Al Windows | Actual Pixels | [ FtScresn | [ Fil Screan | [ PrintSze |

Selected check box

; 5 Displays image at
resizes window

100% magnification

Choosing a Photoshop version

You may have noticed that the title bar on the images in this book say ‘Adobe
Photoshop CS4 Extended’. What's that about? Well, the release of the Adobe Creative
Suite 4 offers two versions of Photoshop: Adobe Photoshop CS4 and Adobe Photoshop
CS4 Extended. The Extended version has additional animation and measurement
features and is ideal for multimedia creative professionals, film and video creative
professionals, graphic and web designers who push the limits of 3D and motion, as
well as those professionals in the fields of manufacturing, medicine, architecture,
engineering and construction, and science and research. Photoshop CS4 is ideal for
professional photographers, serious amateur photographers, graphic and web
designers, and print service providers.
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Use the Zoom tool

1. Click the Indicates layer visibility button

® on the Layers panel for the Toddler
layer so the layer is no longer displayed.

2. Click the Zoom tool <X on the Application bar.
TIP You can also click the Zoom tool on the
Tools panel.

Select the Resize Windows To Fit check box

(if it is not already selected) on the options bar.

4. Position the Zoom In pointer “*{ over the
center of the image, then click the image.

TIP  Position the pointer over the part of the
image you want to keep in view.

5. Press [Alt] (Win) or [option] (Mac), then when
the Zoom Qut pointer appears, click the center of
the image twice with the Zoom Qut pointer {'l.

6. Release [Alt] (Win) or [option] (Mac), then
compare your image to Figure 38.

The zoom factor for the image is 66.7%. Your
zoom factor may differ.

You selected the Zoom tool on the Tools panel and used it

to zoom in to and out of the image. The Zoom tool makes it

possible to see the detail in specific areas of an image, or
to see the whole image at once, depending on your needs.

TR
()

Using the Navigator panel

You can change the magnification factor of an image using the Navigator panel or the Zoom tool
on the Tools panel. You can open the Navigator panel by clicking Window on the Application bar,
then clicking Navigator. By double-clicking the Zoom text box on the Navigator panel, you can
enter a new magnification factor, then press [Enter] (Win) or [return] (Mac). The magnification
factor—shown as a percentage—is displayed in the lower-left corner of the Navigator panel, as
shown in Figure 39. The red border in the panel, called the Proxy Preview Area, defines the area
of the image that is magnified. You can drag the Proxy Preview Area inside the Navigator panel 122.14% -

Zoom tool -
! Q - | [@RK | VIResize Window

options

Zoom tool
on Tools
panel

Fehsuraeopc U NBAS NG 7B

FIGURE 38

Reduced image

Filter Analysis 3D View Window Help

B8 rie Edit Image Layer

___Zoom percentage changed

Zoom Al Windows ual Paceis | | Ft Screen | [ il

&8 rravorou 6.7 RGB/8) *

wose (8 Doc: S85.9K/0 bytes K —

=
&

SN |

Navigator panel

NAVIGATOR [[HISTd #NEo [T o [~=

Viewed
~.area of
B image

to view other areas of the image at the current magnification factor.
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Page Setup dialog box

Page Setup
Paper
Size Letter N
Source Automatically Select -
Orientation Margins {inches)
© Portrait
Landscape
_OK Cancel

Orientation options

Drag handles surrounding
preview to resize image

Positioning
options
Copies to /
: be printed [ FIGURE 41
Selected printer I R
P | | Print dialog box

Scaling options

Previewing and creating a Proof Setup
You can create and save a Proof Setup, which lets you preview your image to see how it will look when printed
on a specific device. This feature lets you see how colors can be interpreted by different devices. By using this

feature, you can decrease the chance that the colors on the printed copy of the image will vary from what you

Modify print settings

Click File on the Application bar, then click
Page Setup to open the Page Setup dialog
box, as shown in Figure 40.
TIP" If you have not selected a printer using
the Print Center, a warning box might
appear (Mac).
Page setup and print settings vary slightly
in Macintosh.

Click the Landscape option button in the
Orientation section (Win) or Click the
Landscape icon (Mac), then click OK.

I TIP

Choose either Landscape option (Mac).

3. Click File on the Application bar, click Print, then

click Proceed in the message box that opens. If
a PostScript dialog box opens, click OK (Mac).

4. Make sure that 1 appears in the Copies text box,
then click Print. See Figure 41.
TIP You can use the handles surrounding
the image preview in the Print dialog box to
scale the print size.
You used the Page Setup command on the File
menu to open the Page Setup dialog box, changed
the page orientation, then printed the image.
Changing the page orientation can make an image
fit better on a printed page.

viewed on your monitor. Create a custom proof by clicking View on the Application bar, pointing to Proof Setup,
then clicking Custom. Specify the conditions in the Customize Proof Condition dialog box, then click OK. Each
proof setup has the .psf extension and can be loaded by clicking View on the Application bar, pointing to Proof
Setup, clicking Custom, then clicking Load.
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Create a PDF with Bridge

1. Click the Launch Bridge button I{Br] on the
Application bar.

2. Click the Folders tab (if necessary), then click
Chapter 1 in the location where your Data Files
are stored in the Folders tab (if necessary).

3. Click the Output button in the Bridge
options bar.

<. Click the PDF button in the Output tab.

5. Click Playground.psd, hold [Shift], click PS 1-
4.psd in the Content tab, then release [Shift].

. Click the Template list arrow, click *5 Contact
Sheet, click Refresh Preview, then compare
your screen to Figure 1-42.

7. Scroll down the Qutput panel, click Save,
locate the folder where your Data Files are
stored, type your name Chapter 1 files in
the text box, then click Save. You may need
to click OK to close a warning box.

You launched Adobe Bridge, then generated a
PDF which was printed using Adobe Acrobat.

Window  Help

- essamias  FumsTae weraoara UG v | o

€ » | Masters > | 1877 > | Chapter1 BE- O~ Sortby Type ™ A

PDF Qutput options in Bridge

[eReaT outeuT PrEVIEw |1

Temclate: | 4%5 Contact Sheet
Refreshoxagen

Page Praset: | International Paper

wadth: BEIER  cantimeters

neght: @IIEE @) @

Qualty: | Hgh Qualty
Sadgrond: wihwe v

Open Password:
Parmission Password

¥ Layout

Unage Placement:  across Frst (By Row)

Use Auto-Spadng
Rotate for Sest At
Fapaat One Photo par Page

Ovarlays

 Flename v Extension
Foat: | Adal v Regua
| sz w0pt v
|| coor s -

¥ Playback
+ Open in Full Sareen Mode
V. Advance every [ seconds

/. Loop After Last Page.

Conrnve: WEURIEN Ton: DI
Rowo: [FHEEISIRE Sotom: GRARUN
Horiontal: BEATE an Lef: DA
vertical: BT o Righv: BEHANE

- L
TTT—— ppF option
Click to
: T~ refresh
x preview
screen

DESIGNTIP Using contrast to add emphasis

Contrast is an important design principle that uses opposing elements, such as colors or lines, to produce an inten-
sified effect in an image, page, or publication. Just as you can use a font attribute to make some text stand out from
the rest, you can use contrasting elements to make certain graphic objects stand out. You can create contrast in
many ways: by changing the sizes of objects; by varying object weights, such as making a line heavier surrounding
an image; by altering the position of an object, such as changing the location on the page, or rotating the image so
it is positioned on an angle; by drawing attention-getting shapes or a colorful box behind an object that makes it
stand out (called a matte); or by adding carefully selected colors that emphasize an object.
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Web Gallery options in Bridge

ESSENTIALS

©) > | Masters > | 1877 > | Datafles > | Chapterl

mustre weracata EEOEE - o &

- B¢ SoctManually ~ A

BREVEER ] OuTPUT PREVIEW |

| conTENT SRR

I outeur

- POF - WE

Tempiste:  Standard v
Style:  Medium Trumbosi v

Refresh Preview Prewiaw in Browsec

¥ Site Info -
Galiery Title:
Adane Ve Galery
Gallery Caption:
My Photographe
About This Galery
ieh Pt Gty crasted by Adobs Bridge

Your Name:
Contactname
E-mad Address:
wser Ddoman, com
Copyright Info:

+/ Show Title Bar

| ¥ Color Palette

{ Background: Menu:
e e
B sl o
B oo Text
e Thumboat
B oreese [ row
| Text Selected

{1 ¥ Appearance
Show Fie Names

Preview Sze: | Madum v
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Web Gallery
button

Create a Web Gallery with
Bridge

Verify that Bridge is open.

Click the Web Gallery button in the Output tab,
click Refresh Preview, then compare your
screen to Figure 43.

Click the View Slideshow button in the
Output Preview window, then click the Play
Slideshow button.

Scroll down the Qutput panel, click the Save to
Disk option button, click the Browse bhutton,
locate the folder where your Data Files are
stored, then click OK (Win) or Choose (Mac).

5. Click Save in the Create Gallery section of the
Output panel, then click OK when the Gallery
has been created.

5. Click File on the Bridge menu, then click Exit
(Win) or click Adobe Bridge CS4, then click
Quit Adobe Bridge CS4 (Mac).

You launched Adobe Bridge, then generated a

Web Gallery.
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What You’ll Do Conci . open files at the same time by exiting the
g oo At the end of your work session, you might program. Closing a file leaves Photoshop
Sl i F have opened several files; you now need to open, which allows you to open or create
Open As. Alts Shifts Ctrl~O decide which ones you want to save. another file. Exiting Photoshop closes the
Open As Smart Object... R
Open Recent > file, closes Photoshop, and returns you to
Share My Screen. TIP the desktop, where you can choose to open
Device Central...

o oW If you share a computer with other people, it's a good idea another program or shut down the com-
Close All AlteCtrle W - ‘ puter. Photoshop will prompt you to save
Close and Go To Bridge.. Shifts Crie W to reset Photoshop’s preferences back to their default . X
) any changes before it closes the files. If
Seveiica. Shift=CtrisS settings. You can do so when you start Photoshop by S 5 s :
P ks ’ you do not modify a new or existing file,
S T s clicking Window on the Auphcatloﬂ bar, pointing to Photoshop will close it automatically when
= Workspace, then clicking Essentials (Default). you exit.
Import >
Scripts < When you are finished working on an To close all open files, click File on the Application bar,
it i et image, you need to save and close it. You then click Close Al
Page Setup... Shift+CtrlsP s . 4
Print Ctiep can close one file at a time, or close all
Print One Copy Alt+Shift«Ctri+P
Exit Ctrl+Q
In this lesson, you’ll use the Close and Exit Using Adobe online
(Win) or Quit (Mac) commands to close a Periodically, when you start Photoshop, an Update dialog box might appear, prompting
file and exit Photoshop. you to search for updates or new information on the Adobe website. If you click Yes,
Photoshop will automatically notify you that a download is available; however, you do
not have to select it. You can also obtain information about Photoshop from the Adobe
Photoshop website (www.adobe.com/products/photoshop/main.html), where you can
link to downloads, tips, training, galleries, examples, and other support topics.
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Close command —-

hGEX A CMREPANNR S B

Exit command —

____ Workspace
switcher

DESIGNTIP Using a scanner and a digital camera

If you have a scanner, you can import print images, such as those taken from photographs,
magazines, or line drawings, into Photoshop. Remember that images taken from
magazines are owned by others, and that you need permission to distribute them. There
are many types of scanners, including flatbed or single-sheet feed. You can also use a
digital camera to create your own images. A digital camera captures images as digital files
and stores them on some form of electronic medium, such as a SmartMedia card or
memory stick. After you upload the images from your camera to your computer, you can
work with images in Photoshop.

You can open a scanned or uploaded image (which usually has a .jpg extension or
another graphics file format) by clicking File on the Application bar, then clicking
Open. All Formats is the default file type, so you should be able to see all available image
files in the Open dialog box. Locate the folder containing your scanned or digital camera
images, click the file you want to open, then click Open. A scanned or digital camera
image contains all its imagery in a single layer. You can add layers to the image, but you
can only save these new layers if you save the image as a Photoshop image (with the
extension .psd).

Lesson 8 Close a File and Exit Photoshop

Mr. Dave Schmidt

Close a file and exit
Photoshop

1.

N

8

o

6.

Click the workspace switcher, then
click Essentials.

Click File on the Application bar, then
compare your screen to Figure 44.

Click Close.

TIP You can close an open file (without
closing Photoshop) by clicking the Close
button in the image window. Photoshop will
prompt you to save any unsaved changes
before closing the file.
If asked to save your work, click Yes (Win)
or Save (Mac).

Click File on the Application bar, then click Exit
(Win) or click Photoshop on the Application bar,
then click Quit Photashop (Mac).
TIP To exit Photoshop and close an open
file, click the Close button in the program
window. Photoshop will prompt you to save
any unsaved changes before closing.
If asked to save your work (the untitled file),
click No.

You closed the current file and exited the program
by using the Close and Exit (Win) or Quit (Mac)
commands.

PHOTOSHOP 1-39

Adobe Photoshop CS4



to do this:

use this method:

Key: Menu items are indicated by > between the menu name and its command.
Blue bold letters are shortcuts for selecting tools on the Tools panel.

to do this:

use this method:

Close a file

Create a new file
Create a workspace
Drag a layer

Exit Photoshop
Hide a layer

Lasso tool

Modify workspace
display

Open a file
Launch Bridge
Open Help

Open Preferences
dialog box

Page Setup

Print File
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[Ctri][W] (Win)
(2€]IW] (Mac)

[Ctrl][N] (Win), (Z£][N] (Mac)

Window > Workspace > Save Workspace
[Ctrl][Q] (Win), (#£][Q] (Mac)

-

& orlL

ESSENTIALS ~

[Ctrl][0] (Win), [#£][0] (Mac)
[F1] (Win), (2] [/] (Mac)

[CtrI][K] (Win)

(] (K] (Mac)

[Shift][CtrI][P] (Win)

[Shift] (2£][P] (Mac)

File > Print or, [Ctrl][P] (Win)

(#€](P] (Mac)

Reset preferences to
default settings

Save a file

Show a layer

Show hidden lasso tools
Show History panel

Show or hide all open panels

Show or hide all open panels, the
options bar, and the Tools panel

Show or hide Swatches panel

Use Save As

Zoom in

Zoom out

Zoom tool

[Shift][AI][Ctrl] (Win)

[Shift] [ aption | (Mac)

[Ctrl][S] (Win)

(#€](S] (Mac)

[Shift] L
8%
[Shift][Tab]

[Tab]

Window > Swatches

[Shift][CtrI][S] (Win)
[Shift] [#£][S] (Mac)

«
[Ctri][+] (Win), (Z£][+] (Mac)

[Alt] X (Win)
[CtrI][-] (Win), (2] [-] (Mac)

Q orz
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Start Adobe Photoshop CS4.

Start Photoshop.

Create a new image that is 500 < 500 pixels,
accept the default resolution, then name and
save it as Review.

Open and save an image.

Open PS 1-3.psd from the drive and folder
where you store your Data Files, and if
prompted, update the text layers.

Save it as Zenith Design Logo.

Use organizational and management
features.
Open Adobe Bridge.
Click the Folders tab, then locate the folder
that contains your Data Files.
Close Adobe Bridge.

Getting Started with Adobe Photoshop CS4

Examine the Photoshop window.

Locate the image title bar and the current
zoom percentage.

Locate the menu you use to open an image.
View the Tools panel, the options bar, and
the panels that are showing.

Click the Move tool on the Tools panel, then
view the Move tool options on the options bar.
Create, save and display a customized
workspace (based on Essentials) called
History and Layers that captures panel
locations and displays the History panel
above the Layers panel.

Use the Layers and History panels.
Drag the Wine Glasses layer so it is above
the Zenith layer, then use the History panel
to undo the state.

Drag the Wine Glasses layer above the
Zenith layer again.

Use the Indicates layer visibility button to
hide the Wine Glasses layer.

Make the Wine Glasses layer visible again.
Hide the Zenith layer.

Show the Zenith layer.

Show the Tag Line layer.

Learn about Photoshop by using Help.

Open the Adobe Photoshop CS4 Help window.
Using the Index, find information about
resetting to the default workspace.
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3. Print the information you find.
4. Close the Help window.

View and print an image.

1. Make sure that all the layers are visible in the
Layers panel.

Click the Zoom tool, then make sure the set-
ting is selected to resize the window to fit.

]

FIGURE 45
Completed Skills Review

3. Zoom in on the wine glasses twice. 2.
4. Zoom out to the original perspective. 3
5. Print one copy of the image.

6. Save your work.

Close a file and exit Photoshop.

1. Compare your screen to Figure 45, then close
the Zenith Design Logo file.

Close the Review file.
Exit (Win) or Quit (Mac) Photoshop.

LY Wine Glasses
- Zenith
- [T oo
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As a new Photoshop user, you are com- FIGURE 46

forted knowing that Photoshop’s Help Sample Project Builder 1
system provides definitions, explanations, A toshop s (o
procedures, and other helpful informa- ;
tion. It also includes examples and
demonstrations to show how Photoshop
features work. You use the Help system
to learn about image size and resolution.

About monitor resolution

Open the Photoshop Help window.

Click the Workspace topic in the topics list.
Click the Panels and menus subtopic, in the
left pane, then click Enter values in panels,
dialog boxes, and the options bar topic.
Click the Display context menus topic, then
read this topic.

Click the Opening and importing images
topic in the left pane.

Click the Image size and resolution topic in
the left pane, then click About monitor
resolution. Print out this topic, then
compare your screen to the sample shown
in Figure 46.
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Kitchen Experience, your local specialty
cooking shop, has just added herb-infused
oils to its product line. They have hired
you to draft a flyer that features these new
products. You use Photoshop to create
this flyer.

6.

Open PS 1-4.psd, then save it as Cooking.
Display the Essentials workspace

(if necessary).

Make the Measuring Spoons layer visible.
Drag the Qils layer so the content appears
behind the Skillet layer content.

Drag the Measuring Spoons layer above the
Skillet layer.

Save the file, then compare your image to
the sample shown in Figure 47.
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([ 100% & Doc: 1.03M/3.84M K

FIGURE 47
Sample Project Builder 2

| “ Cooking.psd @ 100% (Measuring Spoons, RGB/8)

What’s Cooking?
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As an avid, albeit novice Photoshop user, Photoshop experts and critique them on 3. Start Photoshop, then open the down-
you have grasped the importance of how their use of layers. loaded images.

layers affect your image. With a little Save one image as Critique-1 and the
practice, you can examine a single-layer Connect to the Internet, and use your browser other as Critique-2 in the Photoshop
image and guess which objects might to find interesting artwork located on at least format (use the .psd extension).
display on their own layers. Now, you're two websites. 5. Analyze each image for its potential use
ready to examine the images created by Download a single-layer image (in its native of layers.

format) from each website.

Gelting Started with Adobe Photoshop CS4 PHOTOSHOP 1-45

Mr. Dave Schmidt Adobe Photoshop CS4



6. Open the File Info dialog box for Critique-1.psd,
then type in the Description section your
speculation as to the number of layers there
might be in the image, their possible order on
the Layers panel, and how moving the layers
would affect the image.

7. Close the dialog box.

8. Compare your image to the sample shown in
Figure 48, then close the files.
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Sample Design Project

Solo Show in Loz Angeles, CA katrin

@photoshopdiva.com

Formet:  application/vnd. adobe, photoshop

Somered by .
Xim; Import... | v oK ]| Cancel

Critique-1,psd
Description wTc Camera Data Video Data Audio Data Mobie SWF Categories Origin oLb,*
There sppear to be sngle lavers for each of the faces, as well as & laver for the leaves and background
& W &
1) Semicolons or commas can be used 1o seperate multiple values
Unknovn .
Appiication: Adobe Photoshop C54 (11.0x20080714 [20080714.m. 410 2008/07/14:02:00:00 cutoff; m t
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You are preparing to work on a series of

design projects to enhance your portfolio.

You decide to see what information on
digital imaging is available on the Adobe
website. You also want to increase your
familiarity with the Adobe website so
that you can take advantage of product
information and support, user tips and
feedback, and become a more skilled
Photoshop user.

d

Connect to the Internet and go to the Adobe

website at www.adobe.com.

2. Point to Products, then find the link for the
Photoshop family, as shown in Figure 49.

3. Use the links on the web page to search for
information about digital imaging options.

4. Print the relevant page(s).

5. Start Photoshop and open the Photoshop

Help window.

Getting Started with Adobe Photoshop CS4
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6. Search for information about Adjusting 7. Evaluate the information in the documents,
the Monitor Display, then print the and then compare any significant differences.

relevant page(s).

Completed Portfolio Project

& Adabe - Adate Photorhop Family - Mt Firetax
Ele fdt View Hitory Bookmarks Tools Help

omtions  Products  Support

| ADOBE PHOTOSHOP FAMILY

 PHOTOSHOP €54 PHOTOSHOP €54
EXTENDENY :

&~ Photoshop '

Two editions of Photoshop CS4

cs4

tdeal for

] A (I hitpus/wvw.adobe com/products/photashop family - 3Gl

Communitios ~ Company  Downloads

=)

TN 3 2 Settings®

m MY,
Adobe

PHOTOSHOR PHOTOSHOR ELEMENTS 7 PHOTOSHOP SLEMENTS T8 PUOTOSNDR COM
LIGHTROOM 2 E PREMIERE ELEMENTS 1 3 2

sbe Photoshop €54

Photeshop Light

ideal for:
Professi Ideal for.

The nenfessianal sho

v salitinn: Phatos
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CHAPTER 2

Working with Layers
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Examine and convert layers
Add and delete layers
Add a selection from one image to another

Organize layers with layer groups and colors
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Layers Are Everything
You can use Photoshop to create sophis-
ticated images in part because a
Photoshop image can contain multiple
layers. Each object created in Photoshop
can exist on its own individual layer,
making it easy to control the position
and quality of each layer in the stack.
Depending on your computer’s
resources, you can have a maximum of
8000 layers in each Photoshop image
with each layer containing as much or as
little detail as necessary.

[P
The transparent areas in a layer do not increase file size

standing the lr

Layers make it possible to manipulate the
tiniest detail within your image, which
gives you tremendous flexibility when you
make changes. By placing objects, effects,
styles, and type on separate layers, you can
modify them individually without affecting
other layers. The advantage to using
multiple layers is that you can isolate

2-2

effects and images on one layer without
affecting the others. The disadvantage of
using multiple layers is that your file size
might become very large. However, once
your image is finished, you can dramati-
cally reduce its file size by combining all
the layers into one.

You can add, delete, and move layers in
your image. You can also drag a portion of
an image, called a selection, from one
Photoshop image to another. When you do
this, a new layer is automatically created.
Copying layers from one image to another
makes it easy to transfer a complicated
effect, a simple image, or a piece of type.
You can also hide and display each layer, or
change its opacity. Opacity is the ability to
see through a layer so that layers beneath
it are visible. The more opacity a layer has,
the less see-through (transparent) it is.
You can continuously change the overall
appearance of your image by changing the
order of your layers, until you achieve just
the look you want.
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Tools You’ll Use

Duplicate Layers.

Layer Shift« CtrieN

Delete > up
Group from Layers.

Layer Style >

New Fill Layer >

New Adjustment Layer .

Smart Objects ¥

Video Layers »

Rasterize ¥

New Layer Based Slices

Group Layers Ctri+G

Hide Layers

Arrange >

Align »

Lock Layers

Link Layers

Merge Layers

Flatten Image

| New Group
Name:
Color: [ violet -

Mode: Pass Through

-~ Opacity: 100

New Layer

Delete Gro

- D Background a

Group Pro

= Ul ©. 9 a 3

Merge Group
ible Shift+Ctri+E

Merge Vis

Opacity list arrow

Duplicate Group

up

Delete Hidden Layers

New Group

New Group from Layers.
Lock All Layers in Group.

Convert to Smart Object

perties

Flatten Image

Animation Options

Panel Opt

ions

Group

Ctri+E

Close
3 oK Close Tab
%0 Cancel
Load... HIS
Save...
A2 2
3 Invert
Selection @ Image
Selection Preview: None -
OK "New Layer
Cancel Name
Use Previous Layer to Create Chipping Mask
Color: [ None =
Mode « Opactty )0

TORY ACHONS |

i

Delete current
State button

olor list arrow
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What You’ll Do

HISTORY [JSCRRONS {0 [0

o m PS 2-1.psd

LAYERS | EHANNELS | PATHS

o+ a
- Once you go up in & hot-air ..
- Youll nevar come dovent
® |:] Graen + stripad balicon
- I:I Lighthouse bslioan
» Black stripad balioon

o e T R R

In this lesson, you'll use the Layers panel
to delete a Background layer and the Layer
menu to create a Background layer from
an image layer.

PHOTOSHOP 2-4
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The Layers panel lists all the layers
within a Photoshop file and makes it possi-
ble for you to manipulate one or more
layers. By default, this panel is located in
the lower-right corner of the screen, but it
can be moved to a new location by drag-
ging the panel’s tab. In some cases, the
entire name of the layer might not appear
on the panel. If a layer name is too long,
an ellipsis appears, indicating that part of
the name is hidden from view. You can
view a layer’s entire name by holding the
pointer over the name until the full name
appears. The layer thumbnail appears to
the left of the layer name and contains a
miniature picture of the layer’s content, as
shown in Figure 1. To the left of the layer
thumbnail, you can add color, which you
can use to easily identify layers. The Layers
panel also contains common buttons, such
as the Delete layer button and the Create
new layer button.

TP
You can hide or resize Layers panel thumbnails to improve
your computer's performance. To remaove or change the
size of layer thumbnails, click the Layers panel list arrow,
then click Panel Options to open the Layers Panel Options
dialog box. Click the option button next to the desired
thumbnail size, or click the None option button to
remove thumbnails, then click OK. An icon of the selected
thumbnail size or a paintbrush icon appears.

2 .ayer Types

The Layers panel includes several types of
layers: Background, type, adjustment, and
image (non-type). The Background layer:
whose name appears in italics—is always at
the bottom of the stack. Type layers—Ilayers
that contain text—contain the type layer
icon in the layer thumbnail, and image lay-
ers display a thumbnail of their contents.
Adjustment layers, which make changes to
layers, have a variety of thumbnails, depend-
ing on the kind of adjustment. Along with
dragging selections from one Photoshop
image to another, you can also drag objects
created in other applications, such as Adobe

Working with Layers
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Dreamweaver, Adobe InDesign, or Adobe
Flash, onto a Photoshop image, which cre-
ates a layer containing the object you
dragged from the other program window.

3 e to have a
Background layer. However, if you don't have a Background
layer, the background will take on the proper

es, which is more memory ir

One of the benefits of using layers is that you
can create different design effects by rear-
ranging their order. Figure 2 contains the
same layers as Figure 1, but they are
arranged differently. Did you notice that the
yellow-striped balloon is partially obscured by
the black-striped balloon and the lighthouse
balloon? This reorganization was created by
dragging the layer containing the yellow
balloon below the Black striped balloon layer
and by dragging the Lighthouse balloon layer
above Layer 2 on the Layers panel. When
organizing layers, you may find it helpful to
resize the Layers panel so you can see more
layers within the image.

cisely. As you continue working in Photos

p, you'll find they

are very us

II-and soon you probably won't even notice then

Lesson 1 Examine and Convert Layers

Image with multiple layers

&l sanicons in flight.psd @ 100% (Lighthouse batloon, RGB/S) -

Once you go up in a hot-air balloon ...

You'll never come down!

100% .

Doc: 763.5K/erM >
=

Layers panel list arrow

CAVIRS | CHANNES. | PATHS |

Norma: v Opachty:

Type layer
thumbnail

tocki (3 7 + @ o
- [_T__] Youll never came v
> [_T_} Gice you go up in & hot-air ..
e D PRER

[ ] mack sroed toon ‘
=5~ |

s fx. 0 ©. 0 2 3

Position mouse over
layer name to display full title

Image layer
thumbnail

Guide

in fight.psd @ 100% (Type layers, RGB/S) -

Once _\uu'guﬂrfin a hot-air balloon ...

You'll never come down!

(2] Doct 763.5K/4.28M o

Layers rearranged

CAVERS | CHANNELS [PATHS [ ]

Norma ~ Opacity: 100%

i 7+ @ m

You'l never come down!

® [T | oncayougaupinahotar
- D Graan + stripad balloon

® [ 3] ughthouse batoan

- E Slack stripad baican

New layer
order

\._ Overlapping
balloons

. & 2 a3
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[ ing

When you open an image created with a
digital camera, you'll notice that the entire

layer into an image layer (non-type layer),
and you can convert an image layer into a
Background layer. You need to modify the

your changes and want it to be the bottom
layer in the stack.

image appears in the Background layer.
The Background layer of any image is the
initial layer and is always located at the
bottom of the stack. You cannot change its
position in the stack, nor can you change
its opacity or lighten or darken its colors.
You can, however, convert a Background

image layer before converting it to a TIP
Background layer. You might want to con-
vert a Background layer into an image
layer so that you can use the full range of
editing tools on the layer content. You
might want to convert an image layer into
a Background layer after you have made all

efore converting an image layer to a Background layer, you
must first delete the existing Background layer. You can
delete a Background layer by selecting it on the Layers
panel, then dragging it to the Delete layer button on the
Layers panel

Using rulers and changing units of measurement

You can display horizontal and vertical rulers to help you better position elements. To dis-
play or hide rulers, click View on the Application bar, then click Rulers. (A check mark to
the left of the Rulers command indicates that the rulers are displayed.) In addition to dis-
playing or hiding rulers, you can also choose from various units of measurement. Your
choices include pixels, inches, centimeters, millimeters, points, picas, and percentages.
Pixels, for example, display more tick marks and can make it easier to make tiny adjust-
ments. You can change the units of measurement by clicking Edit [Win] or Photoshop
[Mac] on the Application bar, pointing to Preferences, then clicking Units & Rulers. In the
Preferences dialog box, click the Rulers list arrow, click the units you want to use, then
click OK. The easiest way to change units of measurement, however, is shown in Figure 3.
Once the rulers are displayed, right-click (Win) or [Ctrl]-click (Mac) either the vertical or
horizontal ruler, then click the unit of measurement you want. When displayed, the Info
panel, displays the current coordinates in your image. Regardless of the units of measure-
ment in use, the X/Y coordinates are displayed in the Info panel.

Changing units of measurement

TS LY R D e ‘ED % L TN R TR R T
o ] ,.‘ ixels
] e v Inches
Right-click (Win) or P e yo! Cerfimeters
[Ctrl]-click (Mac) to = R ks down!
display measurement a Points
choices ¢ Picas
4 P t
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Yout title bar may

differ (Mac)

Background layer deleted

LAYERS | CHANNELS | PATHS | =

Norma -« Opacity: 100%

Fll: 100%

Green + striped balloon

[j Lighthouse balloon

-
® m Black striped balloon

[ )

Lesson 1 Examine and Convert Layers

Warning box

f Adobe Photoshop CS4 Extended

0 Delete the layer "Background™

Yes No

Don't show again

Background layer

no longer present

History state
indicating layer
conversion

New
Background
layer

New Background layer added to Layers panel

HISTORY [ ACTIONS | =

|
@ = 3
LAVERS | CHANNELS | PATHS |, . =]

Green + striped balicon

Ft] it

-
- m Black striped balloon
-

Convert an image layer into
a Background layer

Open PS 2-1.psd from the drive and folder
where you store your Data Files, then save it
as Balloons in flight.
[IP If you receive a warning box about max-
imum compatibility, or a message stating that
some of the text layers need to be updated
before they can be used for vector-based out-
put, and/or a warning box about maximum
compatibility, click Update and/or click OK.
Click View on the Application bar, click Rulers
if your rulers are not visible, then make sure
that the rulers are displayed in pixels.
TIP If you are unsure which units of meas-
urement are used, right-click (Win) or [Ctrl]-
click (Mac) one of the rulers, then verify that
Pixels is selected, or click Pixels (if necessary).
Click the workspace switcher on the Application
bar, then click History and Layers (created in
the Skills Review in Chapter 1).
On the Layers panel, scroll down, click the
Background layer, then click the Delete
layer button - .
Click Yes in the dialog box, as shown in Figure
4, then compare your Layers panel to Figure 5.
Click Layer on the Application bar, point to
New, then click Background From Layer.
The Sky layer has been converted into the
Background layer. Did you notice that in addi-
tion to the image layer being converted to the
Background layer that a state now appears on
the History panel that says Convert to
Background? See Figure 6.
Save your work.
You displayed the rulers and switched to a previ-
ously created workspace, deleted the Background
layer of an image, then converted an image layer
into the Background layer. You can convert any
layer into the Background layer, as long as you first
delete the existing Background layer.
PHOTOSHOP 2-7
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What You’ll Do

LAYERS | CHANNELS | PATHS | o=
Norma » Opacity: 100% *
Lock: [] 7+ @ Fill: | 100%  *
» Once you go up in a hot-air ... 2
- You'll never came down!

» D Green + striped balloon

A L

B Lighthouse balloon
Black stripad balloon

= . 0O & O & #

9 ¢
=
|

9

@ In this lesson, you’ll create a new layer
using the New command on the Layer
menu, delete a layer, and create a new

layer using buttons on the Layers panel.

PHOTOSHOP 2-8

Because it’s so important to make use of
multiple layers, Photoshop makes it easy
to add and delete layers. You can create
layers in three ways: S Tabls 1 i s G the Layerso
m Use the New command on the
Layer menu.
m Use the New Layer command on the
Layers panel menu.

setting of 100%), which means that objects
on lower layers are not visible. Each layer

Merging layers

You can combine multiple image layers into a single layer using the merging process.
Merging layers is useful when you want to combine multiple layers in order to make
specific edits permanent. (This merging process is different from flattening in that it’s
selective. Flattening merges al// visible layers.) In order for layers to be merged, they
must be visible and next to each other on the Layers panel. You can merge all visible
layers within an image, or just the ones you select. Type layers cannot be merged until
they are rasterized (turned into a bitmapped image layer), or converted into uned-
itable text. To merge two layers, make sure that they are next to each other and that
the Indicates layer visibility button is visible on each layer, then click the layer in the
higher position on the Layers panel. Click Layer on the Application bar, then click
Merge Down. The active layer and the layer immediately beneath it will be combined
into a single layer. To merge all visible layers, click the Layers panel list arrow, then
click Merge Visible. Most layer commands that are available on the Layer menu, such
as Merge Down, are also available using the Layers panel list arrow.

Working with Layers
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m Click the Create a new layer button on
the Layers panel.

Objects on new layers have a default opacity



has the Normal (default) blending mode

applied to it. (A blending mode is a feature
that affects a layer’s underlying pixels, and is
used to lighten or darken colors.)

Photoshop automatically assigns a sequential
number to each new layer name, but you can
rename a layer at any time. So, if you have
four named layers and add a new layer, the
default name of the new layer will be Layer 1.
Although calling a layer “Layer 12" is fine,
you might want to use a more descriptive
name so it is easier to distinguish one layer
from another. If you use the New command
on the Layer menu, you can name the layer
when you create it. You can rename a layer at
any time by using either of these methods:

m Click the Layers panel list arrow, click

TABLE 1: Shortcuts for Navigating the Layers Panel

Use the combination:

[AlLt][[] (Win) or [option][[] (Mac)
[Alt][]] (Win) or [option][]] (Mac)
[Ctrl][[] (Win) or [&£]([] (Mac)

[Ctrl][]] (Win) or [&£]([] (Mac)
[Ctrl][Shift] [[] (Win) or
(2£](Shift] [[] (Mac)
[Ctrl][Shift] []] (Win) or

(2]iShift] [1] (Mac)

Lesson 2 Add and Delete Layers
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Layer Properties, type the name in the
Name text box, then click OK.

m Double-click the name on the Layers
panel, type the new name, then press
[Enter] (Win) or [return] (Mac).

You might want to delete an unused or
unnecessary layer. You can use any of four
methods to delete a layer:

m Click the name on the Layers panel, click
the Layers panel list arrow, then click
Delete Layer, as shown in Figure 7.

m Click the name on the Layers panel,
click the Delete layer button on the

(Mac), then click the Delete layer but-
ton on the Layers panel.

m Drag the layer name on the Layers
panel to the Delete layer button on the
Layers panel.

m Right-click a layer (Win) or [Ctrl]-click
a layer (Mac).

You should be certain that you no longer
need a layer before you delete it. If you delete
a layer by accident, you can restore it during
the current editing session by deleting the
Delete Layer state on the History panel.

Layers panel, then click Yes in the ally, no 1
warning box.
m Click the name on the Layers panel,
press and hold [Alt] (Win) or [option]
Layers panel FIGU
list arrow Layers panel menu
[LATEG | CHARNELS | PATHS | ' “BiEF Shatta
to navigate: > Delete
e Layer

down the Layers panel ‘
up the Layers panel

down one layer*

up one layer*

to bottom of stack™*

to top of stack™

*Excluding the Background layer

command

Delete
layer

E BN < button

Create Clipping Mask AltCtd+G

Create
a new
layer

ose button
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Add a layer using the

Layer menu New Layer dialog box New layer in Layers panel
‘New u;'ﬂ"" PR TRPROE r_"—_l | HISTORY [ ACTIONS | .=
Click the Lighthouse balloon layer on the P oK i = S
Layers panel. Use Previous Layer to Create Clipping Mask Cancel 1
3 : . : Color: [INone = ;‘ Open
Click Layer on the Application bar, point to oy i
i Mode: Nofmal ¥\ Opacty 0 % = = e
New, then click Layer.to gpen the New Layer ‘ B e
dialog box, as shown in Figure 8. | 3 s
A new layer will be added above the active layer. Default name e 3
. Color list arrow
[P You can change the layer name in the i e New Layer ;
New Layer dialog box before it appears on layer names history state ; 2 o 3
the Layers panel. | LAvERS | CHANNELS || PATHS | =
Click OK H norma ~ Opacity: 100%
lock: [ 7 b+ @ Fill: | 100%

The New Layer dialog box closes and the
new layer appears above the Lighthouse
balloon layer on the Layers panel. The New
Layer state is added to the History panel.
See Figure 9.

New layer

Once you go up in 2 hot-air ...

]

gae

You'll never come down!

Grean + striped balloon

0
1
D_]l

You created a new layer above the Lighthouse
balloon layer using the New command on the Layer
menu. The layer does not yet contain any content.

I

Lighthouse balloon

]

AL

Black striped ballcon

0O & O & =

Inserting a layer beneath the active layer

When you add a layer to an image either by using the Layer menu or clicking the
Create a new layer button on the Layers panel, the new layer is inserted above the
active layer. But there might be times when you want to insert the new layer beneath,
or in back of, the active layer. You can do so easily, by pressing [Ctrl] (Win) or
(Mac) while clicking the Create a new layer button on the Layers panel.

PHOTOSHOP 2-10 Working with Layers
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New layer with default settings

| CHANNELS | P et —
LAYERS | CHANMELS | PATHS | = -=
Norma w Opacity: 1009% *
lock: (] & & & Fill: | 1009 *

= Once you go up in a hot-air ...
You'll never come down!

9

9 9 @

9

Black striped balloon

== f~ O & O &

Right-clicking for everyone (Mac)

Mac users, are you feeling left out because you can’t right-click? If so, you’ll welcome

Default settings

Create a new
layer button

this news: anyone (yes, even Mac users!) can right-click simply by replacing the
mouse that came with your computer with any two-button mouse that uses a USB
connector. OS X was designed to recognize secondary clicks without having to add
software. Once you've switched mice, just plug and play! You can then right-click

using the (Win) instructions in the steps.

Lesson 2 Add and Delete Layers

Delete a layer

Position the Layer selection pointer :ﬂ':l over
Layer 1 on the Layers panel.
Drag Layer 1 to the Delete layer button -
on the Layers panel.
TIP You can also delete the layer by drag-
ging the New Layer state on the History
panel to the Delete current state button.
If the Delete the layer “Layer 1” dialog box
opens, click the Don’t show again check
box, then click Yes.
1P Many dialog boxes let you turn off this
reminder feature by selecting the Don’t
show again check box. Selecting these
check boxes can improve your efficiency.
You used the Delete layer button on the Layers
panel to delete a layer.

Add a layer using the Layers
panel

Click the Lightouse balloon layer on the
Layers panel, if it is not already selected.

Click the Create a new layer button al on
the Layers panel, then compare your Layers
panel to Figure 10.

Save your work.

You used the Create a new layer button on the
Layers panel to add a new layer.
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What You’ll Do

-

@ In this lesson, you'll use the Invert check box in the
Color Range dialog box to make a selection, drag the
selection to another image, and remove the fringe

from a selection using the Defringe command.

PHOTOSHOP 2-12

Often the Photoshop file you want to cre-
ate involves using an image or part of an
image from another file. To use an image
or part of an image, you must first select
it. Photoshop refers to this as “making a
selection.” A selection is an area of an
image surrounded by a marquee, a
dashed line that encloses the area you
want to edit or move to another image, as
shown in Figure 11. You can drag a mar-
quee around a selection using four mar-
quee tools: Rectangular Marquee,
Elliptical Marquee, Single Row Marquee,
and Single Column Marquee. Table 2 dis-
plays the four marquee tools and other
selection tools. You can set options for

Cropping an image

each tool on the options bar when the tool

you want to use is active.

In addition to using selection tools,
Photoshop provides other methods for
incorporating imagery from other files.
The Extract command, located on the
Filter menu, separates an image from a
background or surrounding imagery. You
can use the Color Range command,
located on the Select menu, to select a
particular color contained in an existing
image. Depending on the area you want,
you can use the Color Range dialog box to
extract a portion of an image.

You might find an image that you really like, except that it contains a particular por-
tion that you don’t need. You can exclude, or crop, certain parts of an image by using
the Crop tool on the Tools panel. Cropping hides areas of an image from view without
decreasing resolution quality. To crop an image, click the Crop tool on the Tools
panel, drag the pointer around the area you want to keep, then press [Enter] (Win) or

[return] (Mac).
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For example, you can select the Invert

entire layer. You use selections to isolate an yver Conten

check box to choose one color and then

area you want to alter. For example, you Sometimes when you make a selection,
select the portion of the image that is every can use the Magnetic Lasso tool to select then move it into another image, the newly
color except that one. After you select all complex shapes by clicking the starting selected image can contain unwanted pixels
the imagery you want from another image, point, tracing an approximate outline, then that give the appearance of a fringe, or halo.

you can drag it into your open file. clicking the ending point. Later, you can You can remove this effect using a Matting

use the Crop tool to trim areas from a

command called Defringe. This command is
selection. When you use the Move tool to

available on the Layer menu and allows you
drag a selection to the destination image, to replace fringe pixels with the colors of
You can use a variety of methods and tools Photoshop places the selection in a new
to make a selection, which can then be
used as a specific part of a layer or as the

other nearby pixels. You can determine a
layer above the previously active layer. width for replacement pixels between 1 and
200. It's magic!

Marquee selections

Area selected
using the
Rectangular
Marquee tool

Specific element
selected using the
Magnetic Lasso tool

TABLE 2: Selection Tools

tool tool name tool tool name

-L Rectangular Marquee tool A Lasso tool

&2 Elliptical Marquee tool ¥ Polygonal Lasso tool
==a Single Row Marquee tool w Magnetic Lasso tool
i Single Column Marquee tool . Eraser tool

23 Crop tool = Background Eraser tool
™ Magic Wand tool g Magic Eraser tool

Lesson 3 Add a Selection from One Image to Another PHOTOSHOP 2-13
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Make a color range selection

Open PS 2-2.psd from the drive and folder
where you store your Data Files, save it as
Yellow striped balloon, click the title bar,
then drag the window to an empty area of the
workspace so that you can see both images.
[IP When more than one file is open, each
has its own set of rulers. The ruler on the
inactive file appears dimmed.

With the Yellow striped balloon image
selected, click Select on the Application bar,
then click Color Range.

[IPIf the background color is solid, you

can select the Invert check box to pick only
the pixels in the image area.

Click the Image option button, then type 150
in the Fuzziness text box (or drag the slider
all the way to the right until you see 150).

Position the Eyedropper pointer ‘(f' in the

blue background of the image in the Color
Range dialog box, then click the background.

Select the Invert check box. Compare the
settings in your dialog box to Figure 12.

Click OK, then compare your Yellow striped
balloon.psd image to Figure 13.

You opened a file and used the Color Range dialog
box to select the image pixels by selecting the
image’s inverted colors. Selecting the inverse is an
important skill in making selections.

PHOTOSHOP 2-14

Color Range dialog box Marquee surrounding selection
Color Range = R—
B Pl T TE e e
S 2" Sampled Colors =
oK
Color Clusters
Fuz ess Cancel
Load..
Save
1
ki & 4

Selection @ Image

Selectigh Preview: None - 5 o Do SR, 3
Fuzziness Invert check box Marquee surrounds
text box everything that is the

inverse of the blue
background

Using the Place command

You can add an image from another image to a layer using the Place command. Place
an image in a Photoshop layer by clicking File on the Application bar, then clicking
Place. The placed artwork appears fattened inside a bounding box at the center of
the Photoshop image. The artwork maintains its original aspect ratio; however, if the
artwork is larger than the Photoshop image, it is resized to fit. The Place command
works well if you want to insert a multi-layered image in another image. (If all you
want is a specific layer from an image, you should just drag the layer you want into
an image and not use the Place command.)

Working with Layers
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Yellow striped balloon image dragged to Balloons in flight image

@l saticons in flight.psd @ 100% (Layer 1. RGB/8) * -
g . PPV L PUPIRR L JUUVOL . JUPTN L. POUUUOR L VTP L FOPVPIN o POV o OO L. R LB,

Once you go up in a hot-air balloon ...

You'll never come down!

Slight fringe
surrounds object

Document sizes
selected

[ 100% o) Doc: 763.5K/4,230 i

New layer defringed

Losd @ 100% (Layer 1 RGO/

§ 1 - 55 B ol 12 ¥y ocs

Once you go up in a hot-air balloon

You'll never come down!

Yellow striped
balloon in image

Yellow striped balloon moved
to active layer in image

Lesson 3 Add a Selection from One Image to Another

Move a selection to
another image

Click the Move tool ™+ on the Tools panel.

Position the Move tool pointer ">c; any-
where over the selection in the Yellow striped
balloon image.

Drag the selection to the Balloons in flight
image, then release the mouse button.

The Yellow striped balloon image moves to
the Balloons in flight file appearing on Layer 1.

If necessary, use the Move tool pointer ki'
to drag the yellow-striped balloon to the
approximate location shown in Figure 14.
Click the triangle _» | in the document
window status bar, point to Show, then verify
that Document Sizes is selected.

You dragged a selection from one image to another.

You verified that the document size is displayed in

the window.

Defringe the selection

With Layer 1 selected, click Layer on the
Application bar, point to Matting then click
Defringe. Defringing a selection gets rid of
the halo effect that sometimes occurs when
objects are dragged from one image

to another.

Type 2 in the Width text box, then click OK.
Save your work.

Close Yellow striped ballon.psd, then com-
pare the Balloons in flight image to Figure 15.

You removed the fringe from a selection.
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What You’ll Do

In this lesson, you'll use the Layers panel
menu to create, name, and color a layer
group, and then add layers to it. You'll add
finishing touches to the image, save it as a
copy, then flatten it.

PHOTOSHOP 2-16

A layer group is a Photoshop feature that
allows you to organize your layers on the
Layers panel. A layer group contains
individual layers. For example, you

can create a layer group that contains all
the type layers in your image. To create

a layer group, you click the Layers panel
list arrow, then click New Group. As with
layers, it is helpful to choose a descriptive
name for a layer group.

Duplicating a layer

After you create a layer group, you simply
drag layers on the Layers panel directly on
top of the layer group. You can remove lay-
ers from a layer group by dragging them
out of the layer group to a new location on
the Layers panel or by deleting them. Some
changes made to a layer group, such as
blending mode or opacity changes, affect
every layer in the layer group. You can
choose to expand or collapse layer groups,
depending on the amount of information
you need to see. Expanding a layer group

When you add a new layer by clicking the Create a new layer button on the Layers
panel, the new layer contains default settings. However, you might want to create a
new layer that has the same settings as an existing layer. You can do so by duplicating
an existing layer to create a copy of that layer and its settings. Duplicating a layer is
also a good way to preserve your modifications, because you can modify the duplicate
layer and not worry about losing your original work. To create a duplicate layer,
select the layer you want to copy, click the Layers panel list arrow, click Duplicate
Layer, then click OK. The new layer will appear above the original.

Working with Layers
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shows all of the layers in the layer group,
and collapsing a layer group hides all of the
layers in a layer group. You can expand or
collapse a layer group by clicking the trian-
gle to the left of the layer group icon.
Figure 16 shows one expanded layer group
and one collapsed layer group.

If your image has relatively few layers, it’s
easy to locate the layers. However, if your
image contains many layers, you might need
some help in organizing them. You can
organize layers by color-coding them, which
makes it easy to find the layer or the group

Lesson 4 Organize Layers with Layer Groups and Colors

you want, regardless of its location on the
Layers panel. For example, you can put all
type layers in red or put the layers associated
with a particular portion of an image in
blue. To color the Background layer, you
must first convert it to a regular layer.

After you make all the necessary modifica-

tions to your image, you can greatly reduce

Layer groups

{

LAYERS | CHANNELS | PATHS | =
Pass Through v Opacity:| 100% *
Lock: +* 8

@ __1

Wy |_)—8allcons

[:] Lighthouse balloon

Black striped balloon

lj Graen + striped balloon
-

D fx K2 ©. 3 & =

the file size by flattening the image.
Flattening merges all visible layers into a
single Background layer and discards all hid-

den layers. Make sure that all layers that you
want to display are visible before you flatten
the image. Because flattening removes an
image’s individual layers, it’s a good idea to
make a copy of the original image before it is
flattened. The status bar displays the file’s
current size and the size it will be when flat-
tened. If you work on a Macintosh, you'll find
this information in the lower-left corner of
the document window.

Layer group icon

Individual layers

in layer grot
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JUnderstanding Laver Comps
The ability to create a layer comp, a varia-

tion on the arrangement and visibility of
existing layers, is a powerful tool that can
make your work more organized. You can
create a layer comp by clicking the Layer
Comps button on the vertical dock (if it’s

FIGURE

New Layer Comp dialog box Type new comp name

New Layer Comp 3
Name: [ENTIReT Y oK
Apply To Layers: |¥| Visibility Cancel
Position

Appearance (Layer Style)

Comment:

visible), or by clicking Window on the
Application bar, then clicking Layer Comps.
Clicking the Create New Layer Comp button
on the panel opens the New Layer Comp
dialog box, shown in Figure 17, which
allows you to name the layer comp and

set parameters.

Active layer
comp

PHOTOSHOP 2-18

Create New
Layer Comp
button

8l satcons in mght psa ® 100%

Type tayers, RGE/8) *
T I8 iy % Tees

Multiple layer comps, shown in Figure 18,
make it easy to switch back and forth
between variations on an image theme. Say,
for example, that you want to show a client
multiple arrangements of layers. The layer
comp is an ideal tool for this.

Multiple Layer Comps in image

e ——— LUK LTS | SFNAM
T
.

¥

oo »

Add un sdjustment

Rl Layer
EAV e Comps
‘w7 A button

> Luves Presets

> Curves Dresets

v o Tess o !

- Once you go up in a hot-air balloon

o Docs 763.5K/4.28M >

You'll never come down!

Lghtncuse baioor

Back wroad batoon
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New Group dialog box

[ New Group
Name:
Color: [] None -

Mode: Pass Through ~ Opacity:

100

= |

OK
Cancel

%

New layer group name

J Color list arrow

Layers added to the All Type layer group

LAYERS | CHANNELS |'PATHS | =
Norma v Opacity: 100%
Lock: 7+ a FillTT 100%

® ] Al Type

-

-

® EI Green + striped balloon

== f O ®© 0 3 =

Lesson 4

New layer group

Layer group
icon (folder)

Down-pointing
arrow indicates
expanded layer
group

Layers within
group are indented

Organize Layers with Layer Groups and Colors

New layer group in Layers panel

LAYERS | CHANNELS | PATHS | =

Pass Through v Opacity: 100%

lock: L] 7+ @

> Once you go up in a hot-air ...
» You'll never come down!

- D Green + stripad ballcon

2 2 O K o

s x

Create a layer group

Click the Green + striped balloon layer,
click the Layers panel list arrow ~= |
then click New Group.
The New Group dialog box opens, as shown
in Figure 19.
1IP Photoshop automatically places a new
layer group above the active layer.
Type All Type in the Name text box.

Click the Color list arrow, click Green, then
click OK.
The New Group dialog box closes. Compare
your Layers panel to Figure 20.
You used the Layers panel menu to create a layer
group, then named and applied a color to it. This new
group will contain all the type layers in the image.

Move layers to the layer group

Click the Once you go up in a hot-air
balloon layer on the Layers panel, then drag
it on to the All Type layer group.
Click the You’ll never come down! layer,
drag it on to the All Type layer group, then
compare your Layers panel to Figure 21.
[IP If the You'll never come down! layer is
not below the Once you go up in a hot-air bal-
loon layer, move the layers to match Figure 21.
Click the triangle =+ to the left of the layer
group icon (folder) to collapse the layer group.
You created a layer group, then moved two layers
into that layer group. Creating layer groups is a
great organization tool, especially in complex
images with many layers.
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Rename a layer and
adjust opacity

Double-click Layer 1, type Yellow striped bal-

loon, then press [Enter] (Win) or [return] (Mac).

Double-click the Opacity text box on the
Layers panel, type 85, then press [Enter]
(Win) or [return] (Mac).

Drag the Yellow striped balloon layer
beneath the Lighthouse balloon layer, then
compare your image to Figure 22.

Save your work.

You renamed the new layer, adjusted opacity, and
rearranged layers.

Create layer comps

Click Window on the Application bar, then
click Layer Comps.

Click the Create New Layer Comp button
al on the Layer Comps panel.

Type Green off/Yellow off in the Name text
box, as shown in Figure 23, then click OK.

Click the Indicates layer visibility button
® on the Green + striped balloon layer and
the Yellow striped balloon layer.

Click the Update Layer Comp button <% on
the Layer Comps panel. Compare your Layer
Comps panel to Figure 24.

Save your work, then click the Layer Comps
button on the vertical dock to close the
Layer Comps panel.

You created a Layer Comp in an existing image.
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Finished image

B o

n flight.psd @ 100% (Yelic

Overlapping ~ Lower opacity

balloon layers allows pixels on

lower layers to

show through

New Layer Comp

name
Layer Comps panel
LAYER COMPS [INOTES | | v=
Last Document State
)] P
- xR < ad 3

v Visibility Cancel

CHANNELS | PATHS | -

v Opacty: gse

enamed anc

moved layer

New Layer Comp dialog box

o |
OK
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Flatten an image

Click File on the Application bar, then click

188 Save A =
> @ 3 Save As.
,,,,,,, A A B -a A Click the As a Copy check box to add a
w - ¢ Pilipi P check mark, then compare your dialog box
- - | b
s 3 " : i If “copy” does not display in the File
4 " | name text box, click this text box and type
il ‘B B -ﬂ } copy to add it to the name.
e , o Click Save.
=5 j ? ; Photoshop saves and closes a copy of
[ the file containing all the layers and effects.
Click Layer on the Application bar, then click
e | eck box to Flatten Image.
: y of the Click OK in the warning box, if necessary,
————— J then save your work.
Flattened image layer Compare your Layers panel to Figure 26.
Click the workspace switcher on the
B e e @ O T P | = Application bar, then click Essentials.
3 : : g o Close all open images, then exit Photoshop.
E Once you go up in a hot-air balloon ... = bt _'”"
HE ; You'll never come down! = il You saved the file as a copy, and then flattened the
' Master Opacty Changa image. The image now has a single layer.
‘ - 3 ‘;‘: il
= A CP’ANH(LS | PATHS | il
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to do this:

use this method:

to do this:

use this method:

Adjust layer opacity

Change
measurements

Color a layer

Create a layer comp

Create a layer group
Delete a layer

Defringe a selection

Click Opacity list arrow on Layers

panel, drag opacity slider

or

Double-click Opacity text box, type a
percentage

Right-click (Win) or [Ctrl]-click (Mac) ruler
Click Layers panel list arrow, Layer

Properties, Color list arrow

Click Create New Layer Comps button on the
Layer Comps panel al

*=  New Group
6|

Layer > Matting > Defringe

Flatten an image
Use the Move tool

Make a New Background
layer from existing layer

Make a New layer

Rename a layer

Select color range

Show/Hide Rulers

Update a layer comp

Layer > Flatten Image
s orv

Layer > New >
Background From Layer

Layer > New > Layer

or

al

Double-click layer name, type new name

Select > Color Range

View > Rulers

[CtrI][R] (Win)
(#€](R] (Mac)

Key: Menu items are indicated by > between the menu name and its command. Blue bold letters are shortcuts for selecting tools on the Tools panel.
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Examine and convert layers.

Start Photoshop.

Open PS 2-3.psd from the drive and folder
where you store your Data Files, update
any text layers if necessary, then save it

as Music Store.

Make sure the rulers appear and that pixels
are the unit of measurement.

Delete the Background layer.

Verify that the Rainbow blend layer is active,
then convert the image layer to a
Background layer.

Save your work.

Add and delete layers.

Make Layer 2 active.
Create a new layer above this layer using the
Layer menu.

Working with Layers
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Accept the default name (Layer 4), and
change the color of the layer to Red.

Delete Layer 4.

Make Layer 2 active (if it is not already the
active layer), then create a new layer using the
Create a new layer button on the Layers panel.
Save your work.

Add a selection from one image to
another.

Open PS 2-4.psd.

Reposition this image of a horn by dragging the
window to the right of the Music Store image.
Open the Color Range dialog box. (Hint: Use
the Select menu.)

Verify that the Image option button is
selected, the Invert check box is selected,
then set the Fuzziness to 0.

Sample the white background in the preview
window in the dialog box, then close the
dialog box.

Use the Move tool to drag the selection into
the Music Store image.

Position the selection so that the upper-left
edge of the instrument matches the sample
shown in Figure 27.

Defringe the horn selection (in the Music
Store image) using a 3 pixel width.

Close PS 2-4.psd.

Drag Layer 4 above Layer 3.

Rename Layer 4 Horn.

Change the opacity for the Horn layer to 55%.
Drag the Horn layer so it is beneath Layer 2.
Hide Layer 1.

Hide the rulers.

Save your work.
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Organize layers with layer groups
and colors.

:

w

~SNooos

<]

Create a Layer Group called Type Layers
and assign the color yellow to the group.
Drag the following layers into the Type Layers
folder: Allegro, Music Store, Layer 2.

Delete Layer 2, then collapse the Layer
Group folder.

Move the Notes layer beneath the Horn layer.
Create a layer comp called Notes layer on.
Update the layer comp.

Hide the Notes layer.

Create a new layer comp called Notes layer
off, then update the layer comp.

Display the previous layer comp, save your
work, then close the tab group. (Hint: Click
the Layer Comps list arrow, then click Close
Tab Group.)

. Save a copy of the Music Store file using

the default naming scheme (add ‘copy’ to
the end of the existing filename).

Flatten the original image. (Hint: Be sure to
discard hidden layers.)

. Save your work, then compare your image

to Figure 27.
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&8 Music store.psd @ 100% (RGB/8#)
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A credit union is developing a hotline for
members to use to help abate credit card

fraud as soon as it occurs. They're going
to distribute ten thousand refrigerator

Completed Project Builder 1

magnets over the next three weeks. As

part of their effort to build community € &mbat F
awareness of the project, they’ve spon- ;

sored a contest for the magnet design.
You decide to enter the contest.

Open PS 2-5.psd, then save it as Combat
Fraud. The Palatino Linotype font is used in
this file. Please make a substitution if this
font is not available on your computer.
Open PS 2-6.psd, use the Color Range dia-
log box or any selection tool on the Tools
panel to select the cell phone image, then
drag it to the Outlaw Fraud image.

Rename the newly created layer Cell Phone
if necessary, then apply a color to the layer
on the Layers panel. Make sure the Cell

100%

M Combat Fraud.psd @ 100% (Cell Phon... —

Phone layer is beneath the type layers.
Convert the Background layer to an image
layer, then rename it Banner.

Change the opacity of the Banner layer to
any setting you like.

Defringe the Cell Phone layer using the pixel
width of your choice.

Save your work, close PS 2-6.psd, then
compare your image to the sample shown in
Figure 28

Working with Layers
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Your local 4-H chapter wants to promote
its upcoming fair and has hired you to
create a promotional billboard commem-
orating this event. The Board of
Directors decides that the billboard
should be humorous.

Open PS 2-7.psd, then save it as 4H
Billboard. Substitute any missing fonts.
Open PS 2-8.psd, use the Color Range dialog
box or any selection tool on the Tools panel
to create a marquee around the llama, then
drag the selection to the 4-H Billboard image.
Name the new layer Llama.

Change the opacity of the Llama layer

to 90% and defringe the layer containing
the llama.

Save your work, then compare your image
to the sample shown in Figure 29.
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&3 4+ Biboard.psd ® 100% (Llama, RGB/8)

Come join in
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100% s Doc: 468.8K/1.64M »
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A friend of yours has designed a new heat- FIGURE 30
absorbing coffee cup for take-out orders. Completed Design Project
She is going to present the prototype to a
prospective vendor, but first needs to print
a brochure. She’s asked you to design an
eye-catching cover.

| B8 coffee Cover.psd @ 100% (Hot Shot, RGB/8)

1. Open PS 2-9.psd, update the text layers if
necessary, then save it as Coffee Cover. The
Garamond font is used in this file. Please
make a substitution if this font is not available
on your computer.

2. Open PS 2-10.psd, then drag the

entire image to Coffee Cover.

Close PS 2-10.psd.

Rename Layer 1 with the name Mocha.

Delete the Background layer and convert the

Mocha layer into a new Background layer.

6. Reposition the layer objects so they look like
the sample. (Hint: You might have to reor-
ganize the layers in the stack so all layers
are visible.)

7. Create a layer group above Layer 2, name it

Hot Shot Text, apply a color of your choice

to the layer group, then drag the type layers

to it.

Save your work, then compare your image

to Figure 30.

(4 B -
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Harvest Market, a line of natural food
stores, and the trucking associations in
your state have formed a coalition to
deliver fresh fruit and vegetables to food
banks and other food distribution pro-
grams. The truckers want to promote the
project by displaying a sign on their
trucks. Your task is to create a design that
will become the Harvest Market logo.
Keep in mind that the design will be seen
from a distance.

Open PS 2-11.psd, then save it as
Harvest Market. Update the text layers
as necessary.

PHOTOSHOP 2-28

Obtain at least two images of different-sized
produce. You can obtain images by using
what is available on your computer, scan-
ning print media, or connecting to the
Internet and downloading images

Open one of the produce files, select it, then
drag or copy it to the Harvest Market image.
(Hint: Experiment with some of the other
selection tools. Note that some tools require
you to copy and paste the image after you
select it.)

Repeat step 3, then close the two produce
image files.

Set the opacity of the Market layer to 80%.
Arrange the layers so that smaller images
appear on top of the larger ones. (You can
move layers to any location in the image
you choose.)

Create a layer group for the type layers, and
apply a color to it.

Working with Layers
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8. You can delete any layers you feel do not FIGURE 31
add to the image. (In the sample image, the Comp/ered PUWO//O PfO/ECf
Veggies layer has been deleted.) B Harvest Market.psd @ 100% (Type layers, RGB/8%)

9. Save your work, then compare your image
to Figure 31.

10. What are the advantages and disadvantages
of using multiple images? How would you
assess the ease and efficiency of the selec-
tion techniques you’ve learned? Which styles
did you apply to the type layers, and why?

100% 1Y Doc: 729.0K/3.34M

185 v
ur local
armers

Working with Layers
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Modify a marquee

J. Select using color and modify a selection

Make a selection using shapes

. Add a vignette effect to a selection
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Combining images
Most Photoshop images are created using a
technique called compeositing—combining
images from different sources. These
sources include other Photoshop images,
royalty-free images, pictures taken with
digital cameras, and scanned artwork.

How you get all those images into your
Photoshop images is an art unto itself.

You can include additional images by

using tools on the Tools panel and menu
commands. And to work with all these
images, you need to know how to select
them—or exactly the parts you want to
work with.

Understanding Selection Tools
The two basic methods you can use to
make selections are using a tool or using
color. You can use three free-form tools to
create your own unique selections, four
fixed area tools to create circular or rec-
tangular selections, and a wand tool to
make selections using color. In addition,
you can use menu commands to increase

3-2

or decrease selections that you made with
these tools, or make selections based
on color.

Understanding Which
Selection Tool to Use

With so many tools available, how do you
know which one to use? After you become
familiar with the different selection
options, you’ll learn how to look at
images and evaluate selection opportuni-
ties. With experience, you'll learn how to
identify edges that can be used to isolate
imagery, and how to spot colors that can
be used to isolate a specific object.

Combining imager
After you decide on an object that you
want to place in a Photoshop image, you
can add the object to another image by
cutting, copying, and pasting, dragging
and dropping objects using the Move tool,
or using the Clipboard, the temporary
storage area provided by your operating
system.
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Tools You’ll Use

Marquee tool
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Brush tool
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Lasso tool

Magic Wand
tool

Marquee tools
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(O Lasso Tool |
5 5 e
'&;ﬂ Pohygonal Lasso Tool [
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Save Selection...

Feather... Shift+F6
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What You’ll Do
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In this lesson, you’ll make selections
using a marquee tool and a lasso tool,
position a selection with the Move tool,
deselect a selection, and drag a complex
selection into another image.

®

PHOTOSHOP 3-4

The Photoshop selection tools make it
easy to select objects that are rectangular
or elliptical in nature. It would be a
boring world if every image we wanted
fell into one of those categories, so fortu-
nately, they don’t. While some objects are
round or square, most are unusual in
shape. Making selections can sometimes
be a painstaking process because many
objects don’t have clearly defined edges.
To select an object by shape, you need to
click the appropriate tool on the Tools
panel, then drag the pointer around the
object. The selected area is defined by a
marquee, or series of dotted lines, as
shown in Figure 1.

Drawing a rectangular marquee is easier
than drawing an elliptical marquee, but
with practice, you’ll be able to create both
types of marquees easily. Table 1 lists the
tools you can use to make selections using

shapes. Figure 2 shows a marquee
surrounding an irregular shape.

[P
A marquee is sometimes referred to as marching
ants because the dots within the marquee appear to
be moving.

2 o] s

Each time you click one of the marquee
tools, a fastening point is added to the
image. A fastening point is an anchor
within the marquee. When the marquee
pointer reaches the initial fastening point
(after making its way around the image),

a very small circle appears on the pointer,
indicating that you have reached the
starting point. Clicking the pointer when
this circle appears closes the marquee.
Some fastening points, such as those in a
circular marquee, are not visible, while oth-
ers, such as those created by the Polygonal
or Magnetic Lasso tools, are visible.

Making Selections
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After a selection is made, you can move,
copy, transform, or make adjustments to
it. A selection stays selected until you
unselect, or deselect, it. You can deselect
a selection by clicking Select on the
Application bar, then clicking Deselect.
You can reselect a deselected object by
clicking Select on the Application bar, then
clicking Reselect.

TP
You can select the entire image by clicking Select on
the Application bar, then clicking All.

TABLE 1: Selection Tools by Shape

tool button effect
Rectangular e

Marquee tool

Elliptical 22

Marquee tool
Single Row =53
Marquee tool

Elliptical Marquee tool used to create marquee

Creates a rectangular selection. Press [Shift] while
dragging to create a square.

Creates an elliptical selection. Press [Shift] while
dragging to create a circle.

Creates a 1-pixel-wide row selection.

Creates a 1-pixel-wide column selection.

[P

Correcting a Selection Error

At some point, you'll spend a ot of time making a complex
selection only to realize that the wrong layer was active.
Remember the History panel? Every action you do is auto-
matically recorded, and you can use the selection state to
retrace your steps and recoup the time spent. Your fix may
be as simple as selecting the proper History state and
changing the active layer in the Layers panel

Elliptical Marquee
tool surrounds
object

Marquee surrounding irregular shape

Single Column i
Marquee tool

Lasso tool =
Polygonal ¥
Lasso tool

Magnetic ‘Yé"

Lasso tool

Creates a freehand selection.

Creates straight line selections. Press [Alt] (Win) or
[option] (Mac) to create freehand segments.
Creates selections that snap to an edge of an object.
Press [Alt] (Win) or [option] (Mac) to alternate
between freehand and magnetic line segments.

Goc: LT3 .
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Placing a Selection

You can place a selection in a Photoshop
image in many ways. You can copy or cut a
selection, then paste it to a different loca-
tion in the same image or to a different
image. You can also use the Move tool to
drag a selection to a new location.

You can arily change any selected to the Move
tool by pressing and holding [Ctrl] (Win) or (Mac)
When you're finished dragging the selection, release [Ctrl]
(Win) or (Mac), and the functionality of the originally
ected tool returns

PHOTOSHOP 3-6

Using Guides

Guides are non-printing horizontal and
vertical lines that you can display on top
of an image to help you position a selec-
tion. You can create an unlimited number
of horizontal and vertical guides. You
create a guide by displaying the rulers,
positioning the pointer on either ruler,
then clicking and dragging the guide into
position. Figure 3 shows the creation of
a horizontal guide in a file that contains
two existing guides. You delete a guide by
selecting the Move tool on the Tools
panel, positioning the pointer over the
guide, then clicking and dragging it back

FIGURE 3
Creating guides in image

~ Totally Photoshop.psd @ 200% (Awesome Photoshop, RGE/8)

to its ruler. If the Snap feature is enabled,
as you drag an object toward a guide, the
object will be pulled toward the guide. To
turn on the Snap feature, click View on
the Application bar, then click Snap. A
check mark appears to the left of the com-
mand if the feature is enabled.

TIF
Double-click a guide to open the Prefe
change guide colors. width, and other features

s dialog box to

__ Doc: 124.5K/166.0K

\__ Dragging a guide to a new
location
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Rectangular Marquee tool selection
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TABLE 2: Working with a Selection

if you want to:

Move a selection (an image) using
the mouse

Copy a selection to the Clipboard
Cut a selection to the Clipboard
Paste a selection from the Clipboard

Delete a selection

Deselect a selection

Lesson 1 Make a Selection Using Shapes

Mr. Dave Schmidt

then do this:

Position the ™# over the selection,
then drag the marquee and its contents
Activate image containing the
selection, click Edit » Copy
Activate image containing the
selection, click Edit » Cut

Activate image where you want the
selection, click Edit > Paste

Make selection, then press

[Delete] (Win) or [delete] (Mac)
Press [Ctrl][D] (Win) or [(22][D] (Mac)

Create a selection with the
Rectangular Marquee tool

Start Photoshop, open PS 3-1.psd from the
drive and folder where you store your Data
Files, save it as Sewing Box, then click OK if
the Maximize compatibility dialog box displays.
Click the workspace switcher on the Application
bar, click Analysis, click the Layers tab, then
display the rulers (if necessary) in pixels.
Open PS 3-2.psd, then display the rulers in
pixels for this image (if necessary).
Click the Rectangular Marquee tool (i on
the Tools panel.
Make sure the value in the Feather text box
on the options bar is 0 px.
Feathering determines the amount of blur between
the selection and the pixels surrounding it.
Drag the Marquee pointer —+— to select the
tape measure from approximately 20 H/20 V
to 260 H/210 V. See Figure 4.
The first measurement refers to the horizontal
ruler (H); the second measurement refers to
the vertical ruler (V).

TIP You can also use the X/Y coordinates

displayed in the Info panel.
Click the Move tool ™ on the Tools panel,
then drag the selection to any location in the
Sewing Box image.
The selection now appears in the Sewing
Box image on a new layer (Layer 1).

T

1P Table 2 describes methods you can use
to work with selections in an image.

Using the Rectangular Marquee tool, you created a

selection in an image, then you dragged that selec-

tion into another image. This left the original

image intact, and created a copy of the selection in

the destination image.
PHOTOSHOP 3-7
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Position a selection with the
Move tool

Verify that the Move tool ™+ is selected on
the Tools panel, and display the rulers (if
necessary).

If you do not see guides in the Sewing Box
image, click View on the Application bar, point
to Show, then click Guides.

Drag the tape measure so that the top-right
corner snaps to the ruler guides at approxi-
mately 1030 H/250 V. Compare your image to
Figure 5.

Did you feel the snap to effect as you posi-
tioned the selection within the guides? This
feature makes it easy to properly position
objects within an image.

IP If you didn’t feel the image snap to
the guides, click View on the Application
bar, point to Snap To, then click Guides.

Rename Layer 1 Tape Measure.
You used the Move tool to reposition a selection in

an existing image, then you renamed the layer.

Using Smart Guides

Rectangular selection in image

Bl sewing Box.psa @ 66.7%

(Layer 1. RGB/B#) *

B0 TS TR0 R lx‘.-:

|

4% e el
i

AR s e R [ AR

Tape measure

Wouldn't it be great to be able to see a vertical or horizontal guide as you move an object?
Using Smart Guides, you can do just that. Smart Guides are turned on by clicking View on
the Application bar, pointing to Show, then clicking Smart Guides. Once this feature is
turned on, horizontal and vertical purple guidelines appear automatically when you draw a
shape or move an object. This feature allows you to align layer content as you move it.

PHOTOSHOP 3-8
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Deselect command

Select ]

Al Ctri+A
Inverse Shift+ Ctrl+1
All Layers Alt+Ctri+ A

Deselect Layers

Similar Layers
Color Range..

Refine Edge.. Alt+Ctri+R
Modify

Grow

Similar
Transform Selection
Edit in Quick Mask Mode

Load Selection..

Save Selection...

Save Selection dialog box

Save Selection
Destination
Document: PS 3-2.psd
Channel: New
Name:

Operation
@ New Channel

X

OK

Cancel

Lesson 1 Make a Selection Using Shapes

Deselect a selection

Click Window on the Application bar, then
click PS 3-2.psd.

[P

Shortcut can be
used instead of
clicking the menu If you can see the window of the

i image you want anywhere on the screen,
you can just click it to make it active instead

of using the Window menu.

Click Select on the Application bar, then
click Deselect, as shown in Figure 6.

You hid the active layer, then used the Deselect

-] command on the Select menu to deselect the

object you had moved into this image. When you
deselect a selection, the marquee no longer
surrounds it.

Saving and loading a selection

Any selection can be saved independently of the surrounding image, so that if you want
to use it again in the image, you can do so without having to retrace it using one of the
marquee tools. Once a selection is made, you can save it in the image by clicking Select
on the Application bar, then clicking Save Selection. The Save Selection dialog box
opens, as shown in Figure 7; be sure to give the selection a meaningful name. When
you want to load a saved selection, click Select on the Application bar, then click Load
Selection. Click the Channel list arrow, click the named selection, then click OK.
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Create a selection with the
Magnetic Lasso tool

Click the Magnetic Lasso tool 5= on the
Tools panel, then change the settings on the
options bar so that they are the same as
those shown in Figure 8. Table 3 describes
Magnetic Lasso tool settings.

Open PS 3-3.psd from the drive and folder
where you store your Data Files.

Click the Magnetic Lasso tool pointer "25

once anywhere on the edge of the pin cushion,

to create your first fastening point.

| [IP If you click a spot that is not at the edae
I of the pin cushion, press [Esc] (Win) or %]

[Z] (Mac) to undo the action, then start again.

Drag the Magnetic Lasso tool pointer ";;;.:i'
slowly around the pin cushion (clicking at the
top of each pin may be helpful) until it is almost
entirely selected, then click directly over the ini-
tial fastening point. See Figure 9.

Don’t worry about all the nooks and crannies
surrounding the pin cushion: the Magnetic
Lasso tool will select those automatically. You
will see a small circle next to the pointer when
it is directly over the initial fastening point,
indicating that you are closing the selection.
The individual segments turn into a marquee.
If you feel that the Magnetic Lasso
tool is missing some major details while
you’'re tracing, you can insert additional fas-
tening points by clicking the pointer while
dragging. For example, click the mouse but-
ton at a location where you want to change
the selection shape.
You created a selection with the Magnetic
Lasso tool.

PHOTOSHOP 3-10
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Options for the Magnetic Lasso tool

> - '_,,_J F a2 Feather: 0 px 7 Ant-alias Width: 20 px Contrast: 10% Freaquency: S7 &1

Creating a selection with the Magnetic Lasso tool

GB/8#)

&l Ps 3-3.05a @ 100% - <
i LPPPEPP L PPPEPM, . PUPETD, . (PTPPO L. . PVOUPR Lo, OTRTOVL . PO .
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Mastering the art of selections

You might feel that it is difficult when you first start making selections. Making selections is
a skill, and like most skills, it takes a lot of practice to become proficient. In addition to prac-
tice, make sure that you're comfortable in your work area, that your hands are steady, and
that your mouse is working well. A non-optical mouse that is dirty will make selecting an
onerous task, so make sure your mouse is well cared for and is functioning correctly.
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Selection copied into image

Wl Sewing Boxpsd @ 66.7% (Pin Cushion. RGB/8S

T 0 0 o oo L O

Defringing the lay

ackground that r
appears; your results S
will vary

Complex selection
includes only object,
no background

TABLE 3: Magnetic Lasso Tool Settings

setting description

Feather The amount of blur between the selection and the pixels
surrounding it. This setting is measured in pixels and can
be a value between 0 and 250.

Anti-alias The smoothness of the selection, achieved by softening the color
transition between edge and background pixels.

Width The interior width by detecting an edge from the pointer. This
setting is measured in pixels and can have a value from 1 to 40.

Contrast The tool’s sensitivity. This setting can be a value between 1 percent
and 100 percent: higher values detect high-contrast edges.

Frequency The rate at which fastening points are applied. This setting can
be a value between 0 and 100: higher values insert more
fastening points.

Lesson 1 Make a Selection Using Shapes

Move a complex selection to
an existing image

Click the Move tool ™+ on the Tools panel.

[IP You can also click the Click to
open the Tool Preset picker list arrow on
the options bar, then double-click the
Move tool.
Use the Move tool pointer ’3;;; to drag the
pin cushion selection to the Sewing Box image.
The selection appears on a new layer
(Layer 1).
Drag the object so that the left edge of the
pin cushion snaps to the guide at approxi-
mately 600 Y and the top of the pin cushion
snaps to the guide at 200 X using the coor-
dinates on the info panel.
Use the Layer menu to defringe the new Layer 1
at a width of 1 pixel.

5. Close the PS 3-3.psd image without saving

your changes.
Rename the new layer Pin Cushion in the
Sewing Box image.
Save your work, then compare your image to
Figure 10.
Click Window on the Application bar, then
click PS 3-2.psd.
Close the PS 3-2.psd image without saving
your changes.
You dragged a complex selection into an
existing Photoshop image. You positioned
the object using ruler guides and renamed a
layer. You also defringed a selection to eliminate

its white border.
PHOTOSH931 1

Mr. Dave Schmidt

Adobe Photoshop CS4



What You’ll Do

In this lesson, you’ll move and enlarge
a marquee, drag a selection into a
Photoshop image, then position a selec-
tion using ruler guides.

PHOTOSHOP 3-12

Not all objects are easy to select.
Sometimes, when you make a selection,
you might need to change the size or
shape of the marquee.

The options bar contains selection buttons
that help you add to and subtract from a
marquee, or intersect with a selection. The
marquee in Figure 11 was modified into
the one shown in Figure 12 by clicking the
Add to selection button. After the Add to
selection button is active, you can draw an
additional marquee (directly adjacent to
the selection), and it will be added to the
current marquee.

One method you can use to increase the
size of a marquee is the Grow command.
After you make a selection, you can
increase the marquee size by clicking Select
on the Application bar, then by clicking
Grow. The Grow command selects pixels
adjacent to the marquee that have colors

similar to those specified by the Magic
Wand tool. The Similar command selects
both adjacent and non-adjacent pixels.

While a selection is active, you can

modify the marquee by expanding or
contracting it, smoothing out its edges, or
enlarging it to add a border around the
selection. These four commands, Expand,
Contract, Smooth, and Border, are sub-
menus of the Modify command, which is
found on the Select menu. For example,
you might want to enlarge your selection.
Using the Expand command, you can
increase the size of the selection, as shown

in Figure 13.
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After you create a marquee, you can move

the marquee to another location in the
same image or to another image entirely.
You might want to move a marquee if

you've drawn it in the wrong image or the

wrong location. Sometimes it’s easier to

draw a marquee elsewhere on the page, and

then move it to the desired location.

You can al and display layers as necessary to

facilitate making a selection

Add to
selection
button adds
new selection
to the existing
selection

Single
marquee
surrounds
all shapes

New selection

New gar e
selection § @l shapes.psa @ 100% ¢
button used A B
to create a ?
selection -

330

Eil
Marquee
surrounds
rectangle

Lesson 2 Modify a Marquee

Selection with additions

_)@r ]

% (Layer 3, RGB/8%) -

1€ b B b1
o T PR L LR,

L

Lilate)

=

Ll

Add to selection
pointer Marquee
expanded by
5 pixels

The Quick Selection tool lets you paint-
to-select an object from the interior
using a resizeable brush. As you paint
the object, the selection grows. Using
the Auto-Enhance check box, rough
edges and blockiness are automatically
reduced to give you a perfect selection.
As with other selection tools, the Quick
Selection tool has options to add and
subtract from your selection.

Expanded selection

88 shapes.psa @ 100% (Layer 3, RGB/8#) (=]

OF @ e o po

i

Ll

1o

Laludal

Adding and subtracting from a selection

Of course knowing how to make a selection is important, but it’s just as important to
know how to make alterations in an existing selection. Sometimes it’s almost impos-
sible to create that perfect marquee on the first try. Perhaps your hand moved while
you were tracing, or you just got distracted. Using the Add to selection, Subtract
from selection, and Intersect with selection buttons (which appear with all selection
tools), you can alter an existing marquee without having to start from scratch.
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Move and enlarge a marquee

Open PS 3-4.psd from the drive and folder @il Ps 5-4.05d @ 200% (RGE/8 =R
where you store your Data Files. Change the B L P P T L LT T LTI B L
zoom factor to 200%. ]
Click the Elliptical Marquee tool _> on 71
the Tools panel. -

[IP The Elliptical Marquee tool might be ; > 8

hidden under the Rectangular Marquee tool. 8 ; : 1
Click the New selection button ' ' on the ] b
options bar (if it is not already selected). B ;
Drag the Marquee pointer —— to select the g
area from approximately 150 X/50 Y to 200 t e
X/130 Y. Compare your image to Figure 14. _ i
Position the pointer -, in the center of the (]
selection. é.., a Doc: 109.9K/109.9K v

Drag the Move pointer M sothe marquee

covers the thimble, at approximately 100

X/100 Y, as shown in Figure 15. Moved selection
[P You can also nudge a selection to
move it, by pressing the arrow keys. Each

time you press an arrow key, the selection
moves one pixel in the direction of the arrow.

&l Ps 3-4.ps0 @ 200% (RGB/8#) * - o

" 0 IA:‘ - T ]L::l |38, ]xa:l [180, 180 —TIO0

New marquee
location

Click the Magic Wand tool % on the Tools 5.3
panel, then enter a Tolerance of 16, and select s
the Anti-alias and Contiguous checkboxes. j g PN

Click Select on the Application bar, then click E fﬁ{g
. . 4
Similar. RN J
~ : ‘ "

Click Select on the Application bar, point to 1] X o
Maodify, then click Expand. o

Type 1 in the Expand By text box of the « S _—
Expand Selection dialog box, then click OK. =

Deselect the selection.

You created a marquee, then dragged the marquee to | 200% S Doc: 109.9K/109.9K S
reposition it. You then enlarged a selection marquee e

by using the Similar and Expand commands.
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Quick Selection tool settings

Selection moved to the Sewing Box image

Modify a Marquee

Use the Quick Selection tool

Click the Quick Selection tool "\, on the
Tools panel, then adjust your settings using
Figure 16.

1l If you need to change the Brush settings,
click Brush list arrow on the options bar, then
drag the sliders so the settings are 10 px
diameter, 0% hardness, 1% spacing, 0 angle,
100% roundness, and Pen Pressure size.

Position the pointer in the center of the thim-

ble, then slowly drag the pointer to the outer

edges until the object is selected. See Figure 17.
I Sometimes making a selection is easy,
sometimes . . . not so much. Time and prac-

tice will hone your selection skills. It will get
easier.

Click the Move tool ™+ on the Tools panel.
Position the Move pointer b>g; over the
selection, then drag the thimble to the
Sewing Box image.

Drag the thimble so that it is to the left of
the pin cushion and snaps to the vertical
guide at approximately 600 X/550Y.

Defringe the thimble using a setting of 1 pixel.
Rename the new layer Thimble.

Save your work on the sewing box image,
then compare your image to Figure 18.
Make PS 3-4.psd active.

Close PS 3-4.psd without saving

your changes.

You selected an object using the Quick Selection
tool, then you dragged the selection into an
existing image.
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What You’ll Do

@ In this lesson, you’ll make selections
using both the Color Range command
and the Magic Wand tool. You'll also flip
a selection, then fix an image using the
Healing Brush tool.

PHOTOSHOP 3-16

Selections based on color can be easy to
make, especially when the background of
an image is different from the image itself.
High contrast between colors is an ideal
condition for making selections based on
color. You can make selections using color
with the Color Range command on the
Select menu, or you can use the Magic
Wand tool on the Tools panel.

When you select the Magic Wand tool, the
following options are available on the
options bar, as shown in Figure 19:

The four selection buttons.

The Tolerance setting, which allows
you to specify whether similar pixels
will be selected. This setting has a
value from 0 to 255, and the lower the
value, the closer in color the selected
pixels will be.

The Anti-alias check box, which soft-
ens the selection’s appearance.

The Contiguous check box, which lets
you select pixels that are next to one
another.

The Sample All Layers check box,
which lets you select pixels from
multiple layers at once.

Knowing which selection tool to use

The hardest part of making a selection might be determining which selection tool to
use. How are you supposed to know if you should use a marquee tool or a lasso tool?
The first question you need to ask yourself is, “What do I want to select?” Becoming
proficient in making selections means that you need to assess the qualities of the
object you want to select, and then decide which method to use. Ask yourself: Does
the object have a definable shape? Does it have an identifiable edge? Are there com-

mon colors that can be used to create a selection?

Making Selections
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You can use the Color Range command to
make the same selections as with the Magic
Wand tool. When you use the Color Range
command, the Color Range dialog box
opens. This dialog box lets you use the
pointer to identify which colors you want
to use to make a selection. You can also
select the Invert check box to exclude the
chosen color from the selection. The
fuzziness setting is similar to tolerance, in
that the lower the value, the closer in color
pixels must be to be selected.

mand does not

contiguous pixels

Options for the Magic Wand tool

B {_l__'J_r‘ = Tolerance: 32

| Anti-alias |/| Contiguous

After you place a selection in a Photoshop
image, you can change its size and other
qualities by clicking Edit on the Application
bar, pointing to Transform, then clicking

any of the commands on the submenu. After

you select certain commands, small squares
called handles surround the selection. To
complete the command, you drag a handle
until the image has the look you want, then
press [Enter] (Win) or [return] (Mac). You
can also use the Transform submenu to flip
a selection horizontally or vertically.

If you place a selection then notice that the
image has a few imperfections, you can fix
the image. You can fix imperfections such
as dirt, scratches, bulging veins on skin, or
wrinkles on a face using the Healing Brush
tool on the Tools panel.

Sample All Layers

When g someone's portrait, make sure your subject

hT

3 the | ing U
This tool lets you sample an
paint over the imperfections. What is the
result? The less-than-desirable pixels seem
to disappear into the surrounding image.
In addition to matching the sampled pixels,
the Healing Brush tool also matches the
texture, lighting, and shading of the sam-
ple. This is why the painted pixels blend so
effortlessly into the existing image.
Corrections can be painted using broad
strokes, or using clicks of the mouse.

area, then

s and hold [Alt] (Win) or [option]
dragging the pointer over the area you want

Lesson 3 Select Using Color and Modify a Selection PHOTOSHOP 3-17
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Select using color range

1. Open PS 3-5.psd from the drive and folder

where you store your Data Files.
Click Select on the Application bar, then
click Color Range.
Click the Image option button (if it is not
already selected).

4. Click the Invert check box to add a
check mark (if necessary).

5. Verify that your settings match those shown
in Figure 20, click anywhere in the back-
ground area surrounding the sample image,
then click OK.

The Color Range dialog box closes and the
spool of thread in the image is selected.

6. Click the Move tool ™+ on the Tools panel.
7. Drag the selection into Sewing Box.psd,
then position the selection as shown in
Figure 21.
&. Rename the new layer Thread.
9. Defringe the spool of thread using a setting
of 1 pixel.
O.Activate PS 3-5.psd, then close this file
without saving any changes.

=

You made a selection within an image using the
Color Range command on the Select menu, and
dragged the selection to an existing image.

PHOTOSHOP 3-18
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Modifies tolerance

Image sample
appears here

Completed Color Range dialog box

Color Range =
lect: A le s -
Selec Z* Sampled Colors OK
Localzed Color Clusters
Cancel
Fuzziness: 0
Load...
Save
¥ P A
e
YUnvert
Selected check box
Selection @ Image i
excludes selected
Selection Preview: None - color

Selection in image
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FIGURE Select using the Magic
Magic Wand tool settings Wand tool

K- g! 5 | .7 a Tolerancs: 10 v Anti-alias Contiguous Sampla All Laysrs Open PS 3'6.DSd from the drive and folder
where you store your Data Files.

Click the Magic Wand tool "5, on the
Tools panel.

Change the settings on the options bar to
Selected area match those shown in Figure 22.
P ——— - Click anywhere in the background area of
S 3-6.p P 100% ( /8 - -
WL PUPPPOIL - PPPPUPUA L PUPOPIR L PVPVPIL .. DUPUPYL - . PVPPIL L. DUV, .. .PVPVPN o .PVOVPW. - .PVPVPIL .. POPVPON ;... POV the image (such as 50 X/50 Y).

TIP  Had you selected the Contiguous
check box, the pixels within the handles
would not have been selected. The
Contiguous check box is a powerful feature
of the Magic Wand tool.

Click Select on the Application bar, then
click Inverse. Compare your selection to
Figure 23.

Click the Move tool ™s on the Tools panel,
then drag the selection into Sewing Box.psd.

|

A
"

PPt POcron PP PRV

.

Ladadad

You made a selection using the Magic Wand tool,
then dragged it into an existing image. The Magic
Wand tool is just one more way you can make a

Nl

'E selection. One advantage of using the Magic Wand
3 tool (versus the Color Range tool) is the
?: Contiguous check box, which lets you choose pix-
| 3 els that are next to one another.
s 3
; = Dac: 343806438 »
Selection excludes
background color
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Flip a selection

Click Edit on the Application bar, point to
Transform, then click Flip Horizontal.

Rename Layer 1 as Scissors.
Defringe Scissors using a 1 pixel setting.
Drag the flipped selection with the Move tool
pointer ™4 so it is positioned as shown in
Figure 24.
Make PS 3-6.psd the active file, then close
PS 3-6.psd without saving your changes.
6. Save your work.
You flipped and repositioned a selection.
Sometimes it’s helpful to flip an object to help
direct the viewer’s eye to a desired focal point.
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Getting rid of red eye

When digital photos of your favorite people have that annoying red eye, what do
you do? You use the Red Eye tool to eliminate this effect. To do this, select the Red
Eye tool (which is grouped on the Tools panel with the Spot Healing Brush tool,
the Healing Brush tool, and the Patch tool), then either click a red area of an eye or
draw a selection over a red eye. When you release the mouse button, the red eye
effect is removed.
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Healing Brush tool options

&7 ~ | Brush: 1.0 ~ | Mode: Norma « | Source: @ Samplad Pattarn: I:D Aligned | Sample: Currant Layer

Crack removed
from image

Image after using the Healing Brush

[l Sewing Box.nd @ 66.7% (Sewing Box, RGE/BS) *

R T o e oo oo oo e o o

wr Gac 3.4M/18.0M > -
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Fix imperfections with the
Healing Brush tool

1. Click the Sewing Box layer on the Layers panel,
then click the Zoom tool ‘A on the Tools panel.
Click the image with the Zoom tool pointer &%
above the pink spool of thread (in the box) at
750 X/600 Y until the zoom factor is 200% and
you can see the crack in the lid of the box.
3. Click the Healing Brush tool & on the Tools
panel. Change the settings on the options bar
to match those shown in Figure 25.

N

TIP If you need to change the Brush settings,
click the Brush list arrow on the options bar, then
drag the sliders so the settings are 10 px diameter,
0% hardness, 1% spacing, 0° angle, 100% round-
ness, and Pen Pressure size.
4. Press and hold [Alt] (Win) or [option] (Mac),
click next to the crack at any location on the
green lid, such as 700 X/580 Y, then release
[Alt] (Win) or [option] (Mac).
You sampled an area of the box that is not
cracked so that you can use the Healing Brush
tool to paint a damaged area with the sample.
Click the crack (at approximately 720 X/580 Y).
6. Repeat steps 4 and 5, each time choosing a
new source location, then clicking at a paral-
lel location on the crack.
Compare the repaired area to Figure 26.
Click the Zoom tool ‘A on the Tools panel
press and hold [Alt] (Win) or [option] (Mac),
click the center of the image with the Zoom tool
pointer Q until the zoom factor is 66.67%,
then release [Alt] (Win) or [option] (Mac).
8. Save your work, then compare your image to
Figure 27.

(4]

~N

You used the Healing Brush tool to fix an imper-

fection in an image.
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What You’ll Do

" T—— -

In this lesson, you'll create a vignette
effect, using a layer mask and feathering.
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Traditionally, a vignette is a picture or
portrait whose border fades into the sur-
rounding color at its edges. You can use a
vignette effect to give an image an old-
world appearance. You can also use a
vignette effect to tone down an over-
whelming background. You can create a
vignette effect in Photoshop by creating a
mask with a blurred edge. A mask lets you
protect or modify a particular area and is
created using a marquee.

Getting that Healing feeling

A vignette effect uses feathering to fade a
marquee shape. The feather setting blurs
the area between the selection and the
surrounding pixels, which creates a dis-
tinctive fade at the edge of the selection.
You can create a vignette effect by using a
marquee or lasso tool to create a marquee
in an image layer. After the selection is
created, you can modify the feather setting
(a 10- or 20-pixel setting creates a nice
fade) to increase the blur effect on the out-
side edge of the selection.

The Spot Healing Brush tool works in much the same way as the Healing Brush tool in
that it removes blemishes and other imperfections. Unlike the Healing Brush tool, the
Spot Healing Brush tool does not require you to take a sample. When using the Spot
Healing Brush tool, you must choose whether you want to use a proximity match type
(which uses pixels around the edge of the selection as a patch) or a create texture type
(which uses all the pixels in the selection to create a texture that is used to fix the area).
You also have the option of sampling all the visible layers or only the active layer.
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Marquee in image

Vignette in image

Lesson 4 Add a Vignette Effect to a Selection
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FIGURE 29
Layers panel

Marma v Opacity: 100% *
ock: (] 7+ @ Fill: 100% »

Feathered mask creates
Vignette effect vignette effect
fades border

Create a vignette

1. Verify that the Sewing Box layer is selected.

N

Click the Rectangular Marquee tool {_i, on
the Tools panel.

Change the Feather setting on the options
bar to 20px.

(&)

4. Create a selection with the Marquee pointer
— from 50 X/50 Y to 1200 X/800 Y, as
shown in Figure 28.

5. Click Layer on the Application bar, point to
Layer Mask, then click Reveal Selection.

The vignette effect is added to the layer.
Compare your Layers panel to Figure 29.

6. Click View on the Application bar, then click
Rulers to hide them.

7. Click View on the Application bar, then click
Clear Guides.

®

Save your work, then compare your image to
Figure 30.
9. Close the Sewing Box image, select

Essentials from the workspace switcher,
then exit Photoshop.

You created a vignette effect by adding a feathered
layer mask. You also rearranged layers and
defringed a selection. Once the image was fin-
ished, you hid the rulers and cleared the guides.
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to do this:

use this method:

to do this:

use this method:

Copy selection

Create vignette effect

Cut selection

Deselect object

Elliptical Marquee tool

Flip image

Grow selection
Increase selection
Lasso tool
Magnetic Lasso tool

Move tool

Click Edit » Copy or [Ctrl][C] (Win) or
(#£][C] (Mac)

Marquee or Lasso tool, create selection, click
Layer » Layer Mask > Reveal Selection

Click Edit > Cut or [Ctrl][X] (Win) or
(#£]1X] (Mac)

Select > Deselect or [Ctrl][D] (Win) or
(#2][D] (Mac)

o
i ]
N

or-[Shift] M

Edit > Transform > Flip Horizontal
Select > Grow

Select > Similar

&, or [Shift] L

% or [Shift] L

& orV

Move selection marquee

Paste selection

Polygonal Lasso tool
Rectangular Marquee tool

Reselect a
deselected object

Select all objects

Select using color range

Select using Magic Wand tool
Select using Quick Selection tool

Single Column
Marquee tool

Single Row Marquee tool

Position pointer in selection, drag ’oio
to new location

Edit > Paste or [Ctrl][V] (Win) or
(Z](v] (Mac)

¥ or [Shift] L
-4 or [Shift] M

Select > Reselect, or [Shift][Ctrl][D] (Win)
or [Shift](&£][D] (Mac)

Select > All, or [Ctrl][A] (Win) or
(#¢][A] (Mac)

Select » Color Range, click
sample area

S or W, then click image

N, or [Shift] W, then drag pointer over image

=I3

Key: Menu items are indicated by > between the menu name and its command. Blue bold letters are shortcuts for selecting tools on the Tools panel.
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Make a selection using shapes.

1. Open PS 3-7.psd from the drive and folder
where you store your Data Files, substitute
any missing fonts, then save it as Cool cats.

2. Open PS 3-8.tif.

3. Display the rulers in each image window
(if necessary), switch to the Analysis work-
space, then display the Layers panel.

4. Use the Rectangular Marquee tool to select
the entire image in PS 3-8.tif. (Hint: Reset
the Feather setting to O pixels, if necessary.)

5. Deselect the selection.

6. Use the Magnetic Lasso tool to create a
selection surrounding only the Block cat in
the image. (Hint: You can use the Zoom tool
to make the image larger.)

7. Drag the selection into the Cool cats image,
positioning it so the right side of the cat is
at 490 X, and the bottom of the right paw
isat450Y.

8. Save your work.

9. Close PS 3-8.tif without saving any changes.

Modify a marquee.

1. Open PS 3-9.iif.

2. Change the settings on the Magic Wand tool
to Tolerance = 5, and make sure that the
Contiguous check box is selected.

3. Use the Elliptical Marquee tool to create a
marquee from 100 X/50 Y to 200 X/100Y,
using a setting of 0 in the Feather text box.

4. Use the Grow command on the Select menu.

5. Use the Inverse command on the Select
menu.

Making Selections

Drag the selection into the Cool cats image,
positioning it so the upper-left corner of the
selection is near 0 X/0 Y.

7. Defringe the new layer using a width of

2 pixels.

Save your work.

Select using color and modify a
selection.

. Open PS 3-10.tif.
2. Use the Color Range dialog box to select
only the Kitten.
3. Drag the selection into the Cool cats image.
Flip the kitten image (in the Cool cats image)
horizontally.

=N

Completed Skills Review project

{ 8 cool cats.psd @ 100% (Backdrop. Layer Mask/8) S

9. Close PS 3-9.tif without saving any changes.

b
il

|

|
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Position the kitten image so the bottom right
snaps to the ruler guides at 230 X/450 Y.

6. Defringe the kitten using a width of 2 pixels.
7. Save your work.

8. Close PS 3-10.tif without saving any changes.

Add a vignette effect to a selection.

1. Use a 15-pixel feather setting and the
Backdrop layer to create an elliptical selection
surrounding the contents of the Cool cats
image.

2. Add a layer mask that reveals the selection.

3. Hide the rulers and guides, then switch to
the Essentials workspace.

4. Save your work.

5. Compare your image to Figure 31.
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As a professional photographer, you often
take photos of people for use in various
publications. You recently took a photo-
graph of a woman that will be used in a
marketing brochure. The client is happy
with the overall picture, but wants the
facial lines smoothed out. You decide to
use the Healing Brush tool to ensure that
the client is happy with the final product.

Open PS 3-11.psd, then save it as Portrait.
Make a copy of the Original layer using the
default name, or the name of your choice.
Use the Original copy layer and the Healing
Brush tool to smooth the appearance of
facial lines in this image. (Hint: You may
have greater success if you use short
strokes with the Healing Brush tool than if
you paint long strokes.)

Create a vignette effect on the Original copy
layer that reveals the selection using an
elliptical marquee.

Reorder the layers (if necessary), so that the
vignette effect is visible.

Save your work, then compare your image
to the sample shown in Figure 32.
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The St. Louis Athletic Association, which FIGURE 33

sponsors the St. Louis Marathon, is hold- Completed Project Builder 2

ing a contest for artwork to announce the | @8 marathon Contest.psd @ 66.7% (Layer 2, RGB/8#) 7 - o ox |

upcoming race. Submissions can be cre- §
]

ated on paper or computer-generated. ‘ I Ile B 1w

You feel you have a good chance at win-
ning this contest, using Photoshop as
your tool.

1. Open PS 3-12.psd, then save it as
Marathon Contest.
Locate at least two pieces of appropriate
artwork—either on your hard disk, in a
royalty-free collection, or from scanned
images—that you can use in this file.
3. Use any appropriate methods to select
imagery from the artwork.
4. After the selections have been made, copy
each selection into Marathon Contest.
5. Arrange the images into a design that you ! : : 1 ”
think will be eye-catching and attractive. jLes.7% (5 ooy bamean - e = 1
6. Deselect the selections in the files you are
no longer using, and close them without
saving the changes.

N

7. Add a vignette effect to the Backdrop layer.
8. Display the type layers if they are hidden.
9. Defringe any layers, as necessary.
10. Save your work, then compare your screen
to the sample shown in Figure 33.
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You are aware that there will be an open- 8. Deselect the selections in the artwork, then 11. Defringe any images as you see necessary.
ing in your firm’s design department. close the files without saving the changes. 12. Save your work, then compare your screen
Before you can be considered for the job, 9. If desired, create a background layer for to the sample shown in Figure 34.

you need to increase your Photoshop the image.

compositing knowledge and experience. 10. If necessary, add a vignette effect to a layer.

You have decided to teach yourself,

using informational sources on the FIGURE 34
Internet and images that can be scanned Completed Design Project
or purchased.

Bl sampie Compositing.psd @ 100% (Doctor, RGE/B#) =

1. Connect to the Internet and use your
browser and favorite search engine to find
information on image compositing. (Make a
record of the site you found so you can use
it for future reference, if necessary.)

2. Create a new Photoshop image, using the
dimensions of your choice, then save it as
Sample Compositing.

3. Locate at least two pieces of artwork—either
on your hard disk, in a royalty-free collection,
or from scanned images—that you can use.
(The images can contain people, plants, ani-
mals, or inanimate objects.)

4. Select the images in the artwork, then copy

each into the Sample Compositing image,

using the method of your choice.

Rename each of the layers using

meaningful names.

Apply a color to each new layer.

Arrange the images in a pleasing design.

(Hint: Remember that you can flip any

image, if necessary.)

(4]
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At your design firm, a Fortune 500 client 7. If necessary, add a vignette effect to a layer 9. Save your work, then compare your image
plans to start a 24-hour cable sports net- and/or adjust opacity. to the sample shown in Figure 35.

work called Total Sportz that will cover 8. Defringe any images (if necessary).

any nonprofessional sporting event. You
have been asked to create some prelimi-
nary designs for the network, using
images from multiple sources.

FIGURE 35
Completed Portfolio Project

“ Total Sportz.psd @ 100% (Armwrestling, RGB/8#)

1. Open PS 3-13.psd, then save it as Total
Sportz. (Hint: Click Update to close the
warning box regarding missing fonts,

if necessary.)

Locate several pieces of sports-related art-

work—either on your hard disk, in a royalty-

free collection, or from scanned images.

Remember that the images should not show

professional sports figures, if possible.

3. Select imagery from the artwork and move it
into the Total Sportz image.

4. Arrange the images in an interesting design.
(Hint: Remember that you can flip any
image, if necessary.)

5. Change each layer name to describe the
sport in the layer image.

6. Deselect the selections in the files that you
used, then close the files without saving
the changes.

N
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